Table of Contents

Part I  Introduction ............................................... 1

Part II How to Read this Document .......................... 4

Part III Important Notice ........................................ 6

Part IV Overview .................................................. 8

1 General Product Information ................................. 9
   Product Variants .................................................. 9
   About Experiment Center ..................................... 10
   License Information ............................................. 11
   Web Browser Information .................................... 11
   Dongle Protection and License Update ................. 11
      License Update ................................................ 13
      Time Limited Dongle ....................................... 16
      Network Dongle ............................................. 16
      Pay Per Use .................................................. 19
      Automatic Updates ........................................ 22

2 Features and Benefits ........................................ 23

3 Basic Operation ................................................. 25

4 System Setup .................................................... 26

Part V Configuration ........................................... 28

1 Global Settings ................................................ 29

2 Network Settings ............................................ 34
1 Limitations / Setup recommendations .................. 197

2 Dongle Installation and Troubleshooting .............. 199

3 External Video Setup ........................................... 200
   External Video Hardware Setup .......................... 201
   Software Installation ....................................... 207
   Software Configuration .................................... 208
   Sound Setup .................................................. 215
   Ready to Use ............................................... 220

4 External Camera Setup ....................................... 221
   System Setup ................................................ 221
   External Scene Camera Calibration ..................... 224

5 Information on Calibration .................................. 228

6 Information on User camera and Audio Recording .... 229

7 Program Installation ......................................... 230

8 System Requirements ........................................ 231

9 Troubleshooting .............................................. 235

10 Screen recording of media player windows .......... 238

11 Web Stimulus Trial creation when using Mozilla ... 240
   Firefox
12 Integration with Noldus Observer ....................... 240

Part IX Copyright and Trademarks .......................... 241

Part X License Agreement and Warranty .................. 243
Part XI  About SMI  251

Index  254
Introduction

Chapter
1 Introduction

Congratulations on your purchase of SMI Experiment Center™ 3.7, a software designed to make gaze tracking experiments and visual stimuli creation a snap. SMI Experiment Center™ 3.7 and the accompanying SMI iView X™ system and the SMI BeGaze™ software are designed particularly for researchers working in the fields of reading research, psychology, neurology, cognitive neuroscience, marketing research and usability testing.

SMI Experiment Center™ 3.7, the SMI iView X™ system and the SMI BeGaze™ software build up a powerful platform to record and analyze gaze tracking data. This platform supports a broad range of studies ranging from usability testing and market research to psychology and physiological experiments. This platform is ideal for evaluating interactive media such as web sites, software along with print and online advertising.
How to Read this Document

Chapter
2 How to Read this Document

This manual is designed to serve both as online help and as printed documentation of Experiment Center.

The software version covered in this document is: 3.7

You can use this manual in one of these ways:

- Read through the chapters pertaining to particular functions to get background information before using the program.
- Consult the manual as a reference document to find out particular information. You can find a topic either by consulting the table of contents (at the front of the manual), or the index (at the end).

All the information in this manual can also be accessed through the program. Press [F1] to open the Online Help on a menu item or on the element that has currently the input focus or that is selected.

It is probably not necessary to read all the chapters consecutively as there was an effort to make every chapter complete within itself. This means that some phrases may recur. You may leaf through the chapters to look for the topics that interest you. The link references included in the text as well as the table of contents and the index should help you find your way through this document.

You can locate information fast by using the Online Help's table of contents, index or full text search features.
3 Important Notice

**Experiment Responsibility**

Make sure the presented visual stimuli do not harm or injure your participants. SensoMotoric Instruments GmbH is in no way responsible for the experiments you develop, execute, and analyze. Do not offend against your participant’s cultural background, age, psychological condition, or similar.

**Photosensitive Epilepsy**

Some people may have epileptic seizures triggered by light flashes or patterns. This may occur while presenting successive pictures or video material, even if they have never had a seizure before.

Supervise your participants during experiments. Stop immediately and consult a doctor if a participant has the following or similar symptoms:

- Involuntary movements
- Disorientation
- Convulsions
- Loss of awareness
- Altered vision

**Special Characters**

Don't use special characters for stimulus file names, such as 'ä', 'ï', 'Ç' or similar. Use letters A-Z, digits 0-9, or the space character only.
Overview

Chapter IV
4 Overview

4.1 General Product Information

4.1.1 Product Variants

Experiment Center is distributed in different versions and bundles that are customized to the variety of research applications.

- In professional contexts, Experiment Center is delivered together with BeGaze as Experiment Suite Professional, which is available in two variants
  
  o Experiment Suite Professional Package provides qualitative analysis tools for professional screen-based eye tracking studies, such as Website Usability evaluations or studies on product placement.
  
  o Experiment Suite Professional Package Premium Edition adds comprehensive quantitative analytics, with Key Performance Indicators and AOI statistics.

- In scientific contexts BeGaze is delivered together with Experiment Center as part of Experiment Suite Scientific, which is available in three variants. Experiment Suite Scientific provides functionalities required in many scientific scenarios, such as stimulus conditions and advanced statistical visualizations
  
  o Experiment Suite Scientific Basic allows for recording and analysis on static stimuli such as texts, images and pdfs in addition to Experiment Suite Scientific’s fundamental scientific capabilities like questionnaires and Trigger AOIs for gaze contingent paradigms.
  
  o Experiment Suite Scientific Advanced adds recording and analysis capabilities for dynamic stimuli such as video and web content as well as screen recordings to all functionalities of the Basic version. It also supports the retrospective think aloud protocol.
Experiment Suite Scientific Premium provides flexible tools for efficient analysis of specialized paradigms, such as in reading research and linguistics in addition to all functionalities of the Advanced version. It allows for analysis of time-series data as well as aggregation on highly interactive content.

In addition to these Packages, functional analysis modules are available:

- **External Scene Camera Module** allows recording gaze data on real-world surfaces such as supermarket shelves or mobile devices.
- **Frame Grabber Module** offers the functionality to capture screen content from external devices such as gaming consoles or TVs and overlay gaze data.
- **Observation Module** provides tools to monitor and record participant behavior and expressions.
- **Emotiv EEG Module** allows recording of synchronized EEG data with the emotiv headset.

Upgrade modules are also available for BeGaze which allow application-specific analysis options (Multi-user Semantic Gaze Mapping, Index of Cognitive Activity Module, as well as the Advanced Analysis Module as an upgrade for REDn Professional Package Premium Edition)

⚠️ Each brand named in this manual is industrial property of its manufacturer.

### 4.1.2 About Experiment Center

Information about your current installed and licensed Experiment Center version is available in the **About Experiment Center** dialog. This dialog is accessible by selecting **Help** followed by **About...** from the menu bar. The dialog shows which version of Experiment Center is currently installed. To check whether updates are available, refer to section **Automatic Updates**.
4.1.2.1 License Information

Experiment Suite 360° is available in different product variants and with optional functional modules (see Product Variants for an overview). The About Experiment Center dialog gives information on the licensed modules, and will also indicate whether and until which date temporary licenses are available.

4.1.2.2 Web Browser Information

Some product variants of Experiment Suite 360° allow recording of gaze data superimposed on web stimuli. These type of experiments can be performed either with Microsoft Internet Explorer or Mozilla Firefox browsers. The latest approved version of each browser is displayed in the About Experiment Center dialog along with the currently cached version of each browser that Experiment Center uses. In order to ensure optimal conditions for the experiment, it is highly recommended to ensure that the currently cached version and the latest approved browser version match.

4.1.3 Dongle Protection and License Update

Experiment Center is dongle-protected and requires a license.

The following license types are available:

**Single License**

- This type of license allows you to start one instance of Experiment Center and Experiment Center on a computer. The license is protected by a dongle connected to the computer where the programs are executed. This can be extended by a network floating license.

**Network Floating License**

- A network floating license is a license to execute Experiment Center and BeGaze on any computer attached to the local network. This enables a
group of users to share the use of a program. Network licenses are counted in terms of concurrent users. If a department owns a single network license then only one user can execute the program. Other users who attempt to execute the program while a copy is currently running will be denied.

See also:
- Dongle Installation and Troubleshooting
- Product Variants
- Features and Benefits
- Introduction
4.1.3.1 License Update

Experiment Center is dongle-protected and requires a license. If you want to update your Experiment Center version, please contact the SMI sales department to obtain a new license.

Collect license information

The SMI sales department will need your current license information:

1. From the Windows™ start menu, select Programs: SMI: Experiment Suite 360° Remote Update Utility.

2. In the Collect Status Information tab of the Remote Update Utility, click the Collect information button. This will acquire the current license information which is currently stored on the dongle device.
3. You will be prompted to save a file identifying your current Experiment Center license ("Save key status"). Please save the file under your last name for easy identification.

4. Send this file to sales@smi.de.

   You will receive a new license key from SMI.

**Update license**

After you have purchased your new license key (*.v2c file format), update your license as follows:

1. From the Windows™ start menu, select Programs: SMI: Experiment Suite 360° Remote Update Utility.
2. Switch to the **Apply License File** tab.

![Remote Update Utility](image)

**Important:** Ensure that only the Experiment Center dongle is plugged. Remove all other dongles from the PC.

3. Locate the update file (*.v2c) by clicking the browse button ![Browse](image) and click **Apply Update**. This will write the updated license information to the dongle device.

4. You will be prompted that a receipt has been produced to confirm the update. Please send this receipt file to support@smi.de.

5. Close the **Remote Update Utility** and start **Experiment Center**.
Type and status of your licenses are stored on the dongle device, not on the PC on which Experiment Center is installed. With the license update procedure, the dongle is updated. That means, that you can run Experiment Center on any PC when the dongle is plugged in.

4.1.3.2 Time Limited Dongle

**Time Limited Dongles**

There are dongles that contain time limited licenses for certain features. A message will also be displayed when a feature's license expires. After the license expires the feature is no longer available for use.

Time limited licenses can be extended. For more details, please read the License Update chapter.

4.1.3.3 Network Dongle

**Installation of HASP Network Dongle.**

The Hasp Network dongle accepts remote connections from Experiment Center and BeGaze over the network using the TCP/IP protocol. It can be set to accept a maximum of 10 users simultaneously, and the features can be time limited or permanent. For security reasons the network must installed on a computer with private (non-routable) IP address so that the licenses can't be used over the internet by malicious users (see RFC 1918 for additional information).

To use a Hasp Network dongle follow these steps:

- Connect the Hasp Network dongle to the computer where Experiment Suite 360° is installed (we'll call this the Client PC), or to a different computer from the LAN (we'll call this the Host PC).
If Experiment Suite 360° is not installed on the Host PC, please install the Sentinel HASP Run-time Environment.

Make sure the Client PC, running Experiment Suite 360°, is connected to the same LAN as the Host PC.

Start Experiment Center and BeGaze on the Client PC.

The connectivity to a HASP dongle (local and remote) can be verified using the Sentinel HASP Admin Control Center. Sentinel HASP Admin Control Center is a distributed application running in the Internet browser: http://localhost:1947. The list with all Hasp dongles available for the current computer can be found using the menu Administration Options / HASP Keys.

When the user is logged on remotely to the company’s LAN through a VPN connection, in order to use a Hasp network dongle connected to a computer from LAN, a setting has to be made on the Sentinel HASP Admin Control Center running on the client’s computer: the IP of the computer hosting the Hasp network dongle must be typed in Administration Options \ Configuration \ Access to Remote License Managers \ Specify Search Parameters, and then the Submit button must be pressed.

When two HASP dongles are available, one local and one remote (a HASP Network dongle), the local dongle has priority over the remote dongle.

Once the application has started (Experiment Center or BeGaze) the chosen dongle is used throughout the whole application’s current session. In order to switch to a different dongle, the application has to be restarted after the dongle has been replaced.

**Troubleshooting the Hasp Network Dongle**

If the Sentinel HASP Admin Control Center (http://localhost:1947) is not running, there may be two reasons:

- Neither Experiment Suite nor Sentinel HASP Run-time Environment are installed;
- The Sentinel HASP License Manager service is stopped.
• If the Sentinel HASP License Manager service is stopped, one possible reason is because the antivirus software stopped it. In this case the executable file for the HASP License Manager service which is C:\Windows\system32\hasplms.exe must be included in the antivirus Exclusions (or Exceptions) list. Then go to Control Panel \ Administrative Tools \ Services and start the Sentinel HASP License Manager service.

• If new computers can't get a license from the network dongle even if the license number limit from the dongle is not hit then you might have hit the Windows network limit of concurrent connections to the computer holding the network dongle. In this case you can increase this limit by editing a registry key. Warning: proceed with editing registry entries at your own risk (it is recommended to make a backup first). The procedure is as follows: open the registry editor and go to "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\", add a new key of type DWORD named "TcpNumConnections" and set its value to a large enough value (10000 should work, if more is needed increase the value until all the licenses on the dongle can be used; the maximum allowed value is 65000).
4.1.3.4 Pay Per Use

Experiment Center offers a Pay-Per-Use licensing model where you buy a license for a limited number of experiment recordings. Additional recordings can be bought later and added to the license. A recording is defined as doing an experiment run, that is using the Record button and finishing a full recording of the experiment for one participant with the results saved to the Results folder. If you cancel the experiment run at any time before finish and choose to not save the results the use is not subtracted from your left recordings count.

The number of recordings left is displayed in the lower right area of the window near the Record button as seen below.

When the number of recordings left goes below 10 you get a warning
and then a grace period when you get to 0 recordings left

When you reach 0 recording you can still do 20 more recordings that will be charged to your purchase when you buy additional recordings. So if you used 5 of these extra recordings after your license expires and you buy 20 more, after applying the new license you will have 15 recordings left.

If these 20 extra recordings are used up you can't use the application to do recordings anymore and get this error message
You can purchase additional recordings at any time using the "Update Pay-Per-Use License" option from the Help menu:

Press the "Copy Licensing Information to Clipboard" to get a unique string representing your current license and mail it to sales@smi.de. You will receive a new License Update Key from SMI that you need to paste in the given text box below and press the Update button.
4.1.4 Automatic Updates

Experiment Center and BeGaze can check if a new version of Experiment Suite 360° is available for download. The computer must be connected to the internet and the firewall must allow http connections to access to the update location.

Checking is done:

- Automatically when Experiment Center or BeGaze is started but not more than once a day.
- When Check for Updates is executed from the Help menu.

If an update is available, the user can decide to download and install it.
4.2 Features and Benefits

SMI Experiment Center™ 3.7 is an easy to operate software for experiment design and execution. It is complemented by SMI BeGaze™, a software solution for eye tracking data analysis. Together, Experiment Center and BeGaze form SMI’s comprehensive toolset for eye tracking research, SMI Experiment Suite.

Eye tracking data acquisition is performed by SMI iView X™ or SMI iViewRED, depending on the eye tracker used.

Experiment Center delivers experiment design and control in a user-friendly manner, which enables you to handle the Experiment Center functionality out of the box. Experiment Center allows you to prepare and execute eye tracking experiments with the following features:

- A single user interface for managing various functions, including stimulus preview, live gaze monitoring, and precision timing
- Online guide for optimal participant placement in front of the remote eye tracker
- Integrated calibration and validation including support for animated calibration targets and immediate validation of calibration quality
- Calibration and Validation on demand
- Text, images, video, full length web sites, or interactive programs with screen recording or external video sources can be displayed to each participant step by step while the participant's gaze position is monitored and eye tracking data is recorded
- Questionnaire module for multiple-choice and free text questions
- All visual stimuli can be displayed for 500 milliseconds or longer while maintaining high timer accuracy. Text and Image stimuli can be displayed for durations as short as 50 milliseconds
- Presenting the next stimulus can also be triggered by looking into one or more predefined areas of the stimulus ("AOI dwell time trigger")
• Integrated User (Webcam) and Audio recording (requires license for Observation Module)

• Annotations for user behavior coding

• A randomization group function to present groups of stimuli in a non-determined order and randomization of presentation time

• TTL Trigger support

• A lock/unlock function to prevent accidental invalidation of experiments already used in a recording

• A dry run function for test scenario evaluation – without calibration and recording

• An integrated data storage to allow the acquired data to be analyzed in the BeGaze software

Experiment Center runs on a standard PC and connects to the iView X / iViewRED system. The iView X / iViewRED system in turn operates an attached gaze tracking device. Currently supported eye tracking interfaces are

• REDn Scientific, REDn Professional, RED250mobile

• RED, RED4, RED250, RED500

• RED-m

• Hi-Speed 500 Hz, 1250 Hz

• fMRI-LR, fMRI-SV, and the MEG eye tracking systems

Experiment Center can be run directly on the PC running iView X / iViewRED. Alternatively, Experiment Center can be run on a dedicated stimulus PC which is connected to the iView X / iViewRED system using a network link (Dual PC Setup).

Dual monitor operation is also supported. You can present visual stimuli on one monitor while controlling the experiment on a second monitor.
4.3 Basic Operation

Experiment Center is optimized for a typical gaze tracking experiment workflow:

- During experiment design time, you start the Experiment Center software and create the "storyboard" for the visual stimuli to present. You have to lock the experiment to prevent changes during experiment execution. For test purposes you can check the stimuli combination with the dry run function until it is sufficient for your needs. You then save the results to an experiment.

- The necessary data storage is automatically created by Experiment Center. Therefore you simply enter an experiment name. With this experiment name a subdirectory will be created which contains similar named experiment files.

- During experiment execution time, you start Experiment Center which automatically connects to the iView X eye tracker. You load the created experiment and present the prepared stimuli to your participants one by one. Experiment Center now records the participant's eye movements while he or she is viewing at or interacting with the presented stimuli. While recording, Experiment Center automatically stores the eye and gaze tracking data and the corresponding stimuli files to an experiment results directory for later analysis.

A typical gaze tracking experiment involves persons with two different roles: an operator who controls the experiment and a participant whose gaze position and actions are monitored. The operator starts the experiment, enters information for each participant (e.g. the participant's name), and verifies the calibration necessary to adapt the iView X eye tracking software to the participant's eye characteristics.
4.4 System Setup

For eye and gaze tracking experiments with Experiment Center, two different system setups are possible:

- With a single PC setup, one iView X system runs the iView X gaze tracking system as well as Experiment Center. Both components are interconnected using a PC-internal socket connection. This is the recommended standard configuration depicted below.

- With a double PC setup, the iView X gaze tracking system is executed on one PC. This PC is connected to the gaze tracking device which is for example an RED4 interface mounted underneath the visual stimulus monitor. Experiment Center is executed on a second PC. Both components are interconnected using a UDP/IP socket connection (see Global Settings). This setup can be used for example if dedicated performance requirements exist and the CPU usage of the iView X system disturbs the visual presentation or participant interaction.
While it is possible to execute experiments using a single monitor, the standard experiment setup includes a double monitor setup: one monitor for the operator and a second monitor to present the visual stimuli to the participant (see Double Monitor Settings).
Configuration

Chapter V
5  Configuration

5.1  Global Settings

The Global Settings dialog allows you to change the Experiment Center configuration. If you simply want to reconnect Experiment Center to the iView X system, confirm the current settings with OK.
To change the Experiment Center default configuration depicted above proceed as follows:

1. In the Application Window, click . Alternatively, select the Extras: Global Settings menu command.

The Settings dialog opens. The General tab is displayed.

2. In the Connections Settings section, configure the network connection which is used to control and query the iView X system (see Network Settings). Click the Reset button to revert to the program defaults (localhost IP and port settings). Checking "Use One PC Setup" will hide the connection editor fields and will instruct the system to use the default IP and port settings.

3. In the Data Paths section, configure the location where experiment related files are saved (see Directory Structure).

The Experiment Path setting determines the storage location for experiment and stimulus data. For optimal results, the Experiment Path setting shall point to a local hard disk drive.

The Results Path setting determines the storage location for of experiment results created while running an experiment. For optimal results it is strongly recommended that the Results Path setting shall point to a local hard disk drive.

4. In the Experiment Control Keys section change the default keys for Next stimulus and Stop experiment.

5. In the Naming section a prefix can be added to the recorded data files by setting it in the Participant code prefix text box.

6. In the Live preview section, the Show live preview fullscreen option can be activated to automatically show during experiment execution the stimulus preview in fullscreen.
7. Select the **Advanced** tab from the upper dialog area.
8. The **Remote viewer** section allows a live preview of the main application window or of the running experiment, if one is being recorded, to be broadcast on the network. The preview can be watched by connecting to the displayed web addresses from any browser or media player that accepts streaming videos.

The **Broadcast** checkbox toggles the live preview broadcast on and off. The **Port** text box allows changing the TCP port on which the broadcast is sent. The **Performance** slider changes the size of the broadcast video data, making the quality lower as the data size decreases. If the network speed is low moving toward better performance will improve the remote viewing experience.

There are two addresses displayed which are also clickable (clicking them opens the default internet browser). If the first one (name based) doesn't work the alternate one (IP based) should work. Pressing the **Copy to clipboard** buttons will copy the respective address to clipboard so that it can be pasted somewhere else and shared.

9. The **Enable Emotiv EEG Neuroheadset** enables or disables the Emotiv EEG neuroheadset system during recording.

10. In the **User Camera Capture** section choose how to record user activity (Observation Package only)

Activate **Record user camera** and select the connected webcam device from the **Video Source** selection. A preview window is showing the video of the currently selected webcam. The **config** button is opening the webcam specific settings dialog (please refer to user manual of the selected webcam).

Use the **Resolution** list to select the desired video size.

Activate **Record user sound** and select an audio input device from the **Audio Source** selection in order to add audio recording to the webcam video. Audio recording without video recording is not possible.

**User camera and user audio recording requires the observation package license.**

11. Confirm your settings with **OK**.
The changed settings are applied. If they do not exist, Experiment Center now creates the configured directories and also establishes the connection to the iView X system using the configured network settings.

It is not possible to change the directories while an experiment is open.
5.2 Network Settings

Experiment Center needs to be connected to the iView X system in order to control the gaze tracker and to acquire gaze tracking data. With a single PC setup, the iView X software is running on the same system. To establish a connection to the same host, the following default settings are used in Experiment Center:

- **Experiment Center Listening Port**: "5555"
- **iView X System (IP address)**: "localhost" or "127.0.0.1"
- **Port**: "4444"

For the iView X software, complementary settings are required. This means, that

- the listen port in iView X is the sending port of Experiment Center and
- the sending port in iView X is the listening port of Experiment Center.

The **Global Settings** dialog displays the IP address assigned to the PC running Experiment Center next to **Experiment Center (IP Address)**. While you can configure this IP address in iView X, it is needed to use "127.0.0.1" or "localhost" if iView X is running on the same PC.

**Change Network Configuration**

In the iView X **Hardware** dialog, select "Ethernet" in one of the **Remote Interface** drop-down lists. Click the corresponding **Configure** button and copy the configuration depicted below.
5.3 Dual PC Setup

It is possible to run Experiment Center and iView X on different PCs. After each recording the idf file is automatically transferred from the iView X PC to the Stimulus PC running Experiment Center.

Change Network Configuration

With a double PC setup, the iView X software and Experiment Center run on different PCs. To establish a connection, change the IP address in both configuration dialogs:

- In the Experiment Center’s Global Settings dialog, enter the IP address of the PC running the iView X software.
- In the iView X Network Configuration dialog, enter the IP address of the PC running Experiment Center. You may copy the IP address displayed in the Global Settings dialog next to Experiment Center (IP Address).

Unblocking the Firewall

Note that installed firewall products may block the communication. For example, you need to confirm the network connection with the pre-installed Windows personal firewall.
If you trust your local network environment, you can also disable the Windows personal firewall completely.

1. Right click the **Network Environment** icon located on the desktop or in the Windows **Start** menu. Select the **Properties** context menu entry.

2. In the **Network Environment** window, right click the Local Area Connection icon. Select the **Properties** context menu entry.

3. In the **Local Area Connection properties** dialog, navigate to the **Advanced** tab and click **Settings**.

4. In the **Windows Firewall** dialog, navigate to the **General** tab and select **Off**.

5. Confirm with **OK**.
5.4 Dual Monitor Settings

To operate the double monitor setup, the corresponding system functions of the Windows operating system are used. Note that most notebooks provide an additional monitor plug for this. Otherwise you need a graphics adapter with double monitor ("dual head") support.

The following steps activate the second monitor:

1. In the Windows Control Panel, select the Appearance and Themes category. With Windows XP, open the Display Properties applet and switch to the Display Settings tab. With Windows Vista, select the Change display resolution task.
2. Check whether the display driver supports a second monitor. This is the case if two screen icons ("1" and "2") are displayed. Check whether the second monitor is operational. This is true if the second monitor icon is not grayed out. Otherwise plug in and switch on the second monitor. You may need to re-open the Display Properties applet or – with some older notebooks – you may need to restart Windows.

3. Click on the second monitor icon and select the desired screen resolution. Confirm with OK.

In a standard setup, for example if you are the operator sitting in front of an notebook, you may use the second monitor to present the visual stimuli to your participant. To activate the second monitor as stimulus monitor:

1. Select the Display2 entry in the Select Stimulus Monitor control of Experiment Center.

2. Click the Identify button ( ) to verify the double monitor settings. The operator screen is identified by a large 1, while the participant should be placed in front of the monitor displaying a large 2 (Stimulus Monitor). The identify overlay disappears automatically after some seconds.

If you change the Windows monitor setup, you need to restart Experiment Center to update the Select Stimulus Monitor control.
5.5 RED Standalone Setup

Experiment Center can be used to configure the RED stand-alone mode. Experiment Center needs an established connection to iView X and configures remotely the settings in iView X.

The corresponding profiles are stored and handled from iView X and are therefore system dependent.

Select from the menu Extras the submenu RED Operation Mode ....
Switch to **Stand Alone** and then select either an existing profile or press new to create a new one. The following dialog is shown.

The following steps are necessary to setup the RED in stand-alone mode:

1. Remove the RED from the monitor and mount it at the stand-alone foot.

2. Position your external screen (beamer, TV, monitor) as follows:
   - The screen has to be planar.
   - The screen has to be at right angle with the floor.
   - The screen bottom line has to be parallel to the floor.
According to 1) Experiment Setup

3. Enter a new profile name in the **Mode name** field.

4. Enter the geometric dimensions of your setup. Therefore check **Use Placement Suggestion**. Select the distance between floor and the test person's eyes.

According to 2) Setup Stimulus Screen

5. Measure screen width, height and distance bottom line of screen to floor and enter the values.

According to 3) Suggest Placement

6. Optionally, you can select **Suggest RED Placement** and iView X will suggest the values in 4) based on the information given in 1) and 2).

According to 4) Position RED

7. Place your RED according to the suggestions.
8. RED is in the horizontal middle of the screen.
9. The screen bottom line has to be parallel to the RED.
10. Press OK.

⚠️ To review if the profile fits, place a test person in front of the RED and check if the eyes are in the middle of the tracking monitor, if this is not the case, correct the distance RED to floor and the RED inclination angle and correct the parameters in the profile. Test your experiment once and check if there is a stable tracking over the whole screen.

Calibration Targets
Selecting the second tab, called Points, allows editing the calibration type and calibration target positions.

The number of calibration points can be selected on the right side and the calibration points can be moved using the mouse. A custom image for the calibration area background can be loaded using the Load Image button.
Step-by-step Instructions
6 Step-by-step Instructions

6.1 Step-by-step: Overview

In Experiment Center, you process the measurement data using the following steps:

1. Prepare the experiment: You can start with a new experiment or open an existing one and modify it. To modify an experiment, you have to unlock it.

   Preparation also consists of calibration and selection of the appropriate visual stimuli (such as text or images) which fits to the research objective. As an option, you may also add custom participant properties allowing you to characterize/group individual participants during the experiment.

2. End preparation by locking the experiment.

3. Test the experiment design with a dry run.

4. Run experiment: If the dry run meets your requirements, start the experiment. The system will perform calibration and after that present the stimuli to the participant.

   The experiment and its results will be stored according to the defined directory structure.

5. Analyze the measurement data using the BeGaze analysis software.

6. For database maintenance, you may delete unnecessary experiments later on.

The following topics in this help book provide step-by-step instructions to carry out these specific tasks with Experiment Center.
6.2 Starting Experiment Center

As a precondition, the iView X system needs to run in order to allow Experiment Center to auto-connect:

1. Double click the iView X icon on the desktop.

   ![iView X icon]

2. To start Experiment Center, use the Windows Start: All Programs: SMI: Experiment Suite 360°: Experiment Center 2.4 menu command. Alternatively, double click the following icon on the desktop.

   ![Experiment Center icon]

   During startup, Experiment Center automatically tries to establish a connection to the iView X system. If that fails, Experiment Center tries to establish a connection with the settings from the last successful session.

3. Check the status of the connection by examining the connection button:

   ![Connection status]

   Indicates that the connection is established. When the mouse cursor is over the icon, information is shown about the connected eye tracking device and iView X software version.

   Indicates that the connection is currently not established.

As long as no connection is established, you cannot start a recording. If this is the case, check whether iView X is running and if the connection settings are correct (see Global Settings).
6.3 Preparing Experiments

6.3.1 Creating a New Experiment

An experiment is a set of visual stimuli that are presented in a sequential order to the participant.

Create experiment

To create a new experiment proceed as follows:

1. Double click the icon on the desktop.
   
   The Application Window opens. It is already disposed to create a new experiment. The calibration element is already included in the list of stimuli.

2. Add new stimuli and edit the stimuli’s properties.

3. Set calibration properties.

4. Optional: add participant properties.

5. When setting is completed, click to lock the experiment. This way settings cannot be changed accidentally.

6. Save the experiment (see Saving Experiments).

The currently logged in user information added the new experiment automatically. The creating user information only includes the username. This information helps you to identify experiments, for example if you reopen experiments later on or if you analyze the experiment using BeGaze.

Execute experiment

Start the experiment (see Running an Experiment) or test the settings with a dry run.
6.3.2 Loading and Changing an Experiment

In a typical gaze tracking experiment the stimulus presentation may be adapted to a modified research objective. You can create a new experiment for this, but it is also possible to modify an existing one.

Load and change experiment

To modify an existing experiment proceed as follows:

1. Click in the top toolbar.

   The Load experiment dialog opens, presenting a list of existing experiments.
2. Select the desired experiment.

3. Click **Load**.

   The experiment is loaded into the **Application Window**.

4. Ensure that the experiment is unlocked (**`). If it is locked, click to unlock.

5. Edit or modify experiment settings:

   Add new stimuli or change the stimuli settings. The order of stimuli can be changed as well (for more information see the help topic entitled **Setting Stimuli**).

   Change calibration **properties**.

6. Click **`** to lock the experiment. This way settings cannot be changed accidentally.

7. Save the experiment (see **Saving Experiments**).

**Execute experiment**

Start the experiment (see **Running an Experiment**) or test the changed settings with a **dry run**.
6.3.3 Saving Experiments

To save an experiment proceed as follows. Note that you do not simply save an experiment file. Instead, Experiment Center uses the experiment name to create a subdirectory in the experiments directory which contains all used stimulus files and the experiment file (see Data Storage Structure).

1. Click  in the top toolbar. Alternatively, select the File: Save menu command or press the [ CTRL] + [ S] key combination.

   The Save experiment dialog opens presenting a list of existing experiments.

2. Enter a relevant experiment name and add a short experiment description in the input fields of this dialog. Do not use characters not valid for file names, such as “/”, “\”, “:”, “|”, or “<”. Use letters A-Z, digits 0-9, or the space character instead.

3. Click Save.

   Overwriting an existing experiment might invalidate already acquired eye tracking data.
Save experiment to a new name

1. Select **Save as...** from the **File** menu to save the experiment with a new name.

2. In the **Save experiment** dialog, enter the new name in the **Name of Experiment** field.

3. Add a short experiment description in the **Description of Experiment** input field.

4. Change the **Created by** information if desired. This information is inserted automatically when creating a new experiment.

5. Click **Save**.
6.3.4 Delete Experiments

Over time, the Experiment Center data base may include superfluous experiments. You can remove experiments with the following steps. Note that the corresponding sub-directory is removed from the Experiments folder (see Data Storage Structure).

1. From the File menu, select the Delete Experiments... command.

   The Delete Experiment dialog opens.

   ![Delete Experiment Dialog](image)

   2. Select one or more experiments from the list. Press the [ CTRL ] key and select additional entries concurrently.

   3. Click Delete.

      A query dialog opens, asking for confirmation. Click on Cancel to stop now. Click on Delete to confirm.
4. After the first confirmation, a second query dialog opens asking if you also want to remove previous recorded results from the hard disk.

Click **Delete** to remove the results. Click **Keep Results** if you do not want the results to be removed.

⚠️ You cannot revert the deletion of data after confirming one of the security queries. For this reason, you should make backups of your user data frequently.

### 6.3.5 Rename Experiment

To rename previously saved experiments proceed as follows:

1. From the **File** menu, select the **Rename Experiments...** command.
2. Select the experiment to rename from the list.
3. Type the new name in the "Name of Experiment" text box and click the "Rename" button.

6.3.6 Import/Export Experiments and Results

Please see Import and Export of Experiment and Results.

6.3.7 Stimulus Lists

This feature allows generating experiments defined with a spreadsheet editor starting from a template that provides the most appropriate base design and functionality.

The functionality that can be specified in the template is a subset of the features present in Experiment Center.

Template File Format

The template file must be in the OpenXML format (xlsx). Common software supporting this format are Microsoft Office (commercial) and Libre Office (free). To use a template file to create an experiment in Experiment Center go to the File menu -> Import -> Stimulus Lists and select the template file.

A set of template examples is automatically copied on Desktop in a folder called Stimulus Lists Examples.

Defining stimuli

The stimuli can be defined with the following sheet format:
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
<th>Property1</th>
<th>Property2</th>
</tr>
</thead>
<tbody>
<tr>
<td>name of stimulus 1</td>
<td>type keyword</td>
<td>stimulus specific content definition</td>
<td>property 1 value for stimulus 1</td>
<td>property 2 value for stimulus 1</td>
</tr>
<tr>
<td>name of stimulus 2</td>
<td>type keyword</td>
<td>stimulus specific content definition</td>
<td>property 1 value for stimulus 2</td>
<td>property 2 value for stimulus 2</td>
</tr>
</tbody>
</table>

The first row acts as table header for the defined properties.

The properties headers are assigned using the following predefined keywords (applies to all stimuli):

- **Name**: Acts as definition point for a new stimulus and also sets the name of stimulus.
- **Type**: The stimulus type (text, image and video stimuli can only be added as composite stimuli, which is the default if no type is specified).
- **Content**: Describes the content of the stimulus (specific to each stimulus, see the stimuli below)
- **Audio**: The associated audio playback. Can have the values "stop", "continue" or the name of an audio file that resides in the same folders as the spreadsheet.
- **Duration**: The stimulus duration. Can have the values "manual" or a value in milliseconds.
- **Condition**: A stimulus condition. The header cell must have the syntax "Condition:name", for example: "Condition: relevant"
- **Group** (aliases: Randomization, Randomization Group): The stimulus randomization group.
- **Task**: The stimulus task.
The keywords can be set with any case (i.e. 'Calibration', 'calibration' or 'CALIBRATION' will be interpreted in the same way).

At least one of the **Name** or the **Type** columns must have a value. The **Name** column must be the first column.

The stimulus list progresses from top to bottom with each new defined stimulus, while the properties progress from left to right.

Defining a certain type of stimulus involves in general setting the proper 'Type' keyword and adding specific items in the 'Content' column, where it applies:

- **Calibration**: set the 'Type' to 'calibration'. The default calibration method will be used.
- **Validation**: set the 'Type' to 'validation'
- **Question** or **Multiple answer**: set the 'Type' to 'question' or 'selection'

Possible 'Content' items (one or more rows):

- The first defined content item is the question. Example: 'How are you today?'
- Next possible items are:
  - 'free answer' (aliases: '...', '…') will generate a free text input
  - text content example: 'fine' will generate a possible answer

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>age</td>
<td>question</td>
<td>How old are you?</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 - 50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt; 50</td>
</tr>
<tr>
<td>feedback</td>
<td>question</td>
<td>Please give us some feedback!</td>
</tr>
<tr>
<td>Name</td>
<td>Type</td>
<td>Content</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>topics</td>
<td>selection</td>
<td>Please check the topics you found the most interesting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nature</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technology</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Web**: set the 'Type' to 'web'

  Possible 'Content' items (one or more rows):
  - an url like "[www.smivision.de](http://www.smivision.de)" sets the page to navigate to
  - 'firefox' sets the browser to be Mozilla Firefox
  - 'ie' (aliases: 'iexplore', 'internet explorer', 'explorer') sets the browser to be Microsoft Internet Explorer

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>web</td>
<td></td>
<td><a href="http://www.smivision.de">www.smivision.de</a></td>
</tr>
<tr>
<td></td>
<td>firefox</td>
<td></td>
</tr>
</tbody>
</table>

- **Screen Recording**: set the 'Type' to 'screen recording'
- **External Camera**: set the 'Type' to 'external camera'
- **External Video**: set the 'Type' to 'external video'
- **Composite**: set the 'Type' to 'composite'.
A composite will be generated for everything else that is not in the list above. That means text, image and video stimuli can only be added as composite stimuli, not as separate text, image or video as can be done in the application.

Possible 'Content' items (one or more rows):

- rich text content (the formatting of font size, color etc of the cell is applied to the generated item)
- The file name of an image, video, .rtf or .txt file. The file must reside in the same folder as the spreadsheet.
- **Animated Target**. An animated target item is generated if one of the following keywords is found:
  - 'static target' (alias: 'target:static')
  - 'linear target' (alias: 'target:linear ')
  - 'sinusoidal target' (alias: 'target:sine')
  - 'saw tooth target' (alias: 'target:saw')

Properties can be set for each item using property columns. Possible composite item properties:

- Position properties, allowing the same syntax as the composite editor in Experiment Center (percent relative to screen size, absolute value in pixels or keywords like center, proportional, original etc):
  - Width
  - Height
  - X (alias: PositionX)
  - Y (alias: PositionY)
- **AOI**: Sets the AOI name associated with the composite item. This also sets 'Associate AOI' to 'yes'.
- **Associate AOI**: can be 'yes' or 'no'. When 'yes', an AOI is associated with the composite item. This column is optional if 'AOI' is set.
- **AOI Padding** (alias: **Padding**): The padding in pixels of the associated AOI. Can have negative values.

- **Trigger AOI**: when set to "yes", the composite item will have a trigger AOI associated with it. The trigger area is the same as the associated AOI (the size of the trigger can be controlled with the AOI Padding property).

- **Trigger Duration** The AOI trigger duration in milliseconds. If this property is set, the Trigger AOI is automatically set to "yes" as well.

- Properties related to the animated target only:
  - 'target:start time'. The onset in milliseconds of the target.
  - 'target:end time'. The offset in milliseconds of the target.
  - 'target:duration' (alias: 'target:period') .
    - For the linear target, sets the duration in milliseconds of the one time movement.
    - For the periodic targets, sets the period in milliseconds.
  - 'target:end x' and 'target:end y'. Applies to linear target only. The end point of the movement. Can be specified in pixels, percent or predefined position
  - 'target:amplitude x' and 'target:amplitude y' (aliases: 'target:ampl x' and 'target:ampl y'). Applies to period targets only. Can be specified in pixels or percent.
  - 'target:shape'. Sets the style of the target.
    - 'circle' (aliases:'0', 'o'). The standard target.
    - 'cross' (aliases: '+'). The cross target.
    - image file name. Custom target
    - The visual style of the value cell affects the generated target:
- the background of the cell (if set) is applied to the fill color of the target
- the text color of the cell (if set) is applied to the center color of the target
  - 'target:fill' and 'target:center'. The background of this cell, if set, controls the fill, respectively the center color of the target (has priority over the visual style of the 'target:shape' cell).

Example:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
<th>X</th>
<th>Y</th>
<th>AOI</th>
<th>AOI Padding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intro</td>
<td>image.png</td>
<td>10 %</td>
<td>center</td>
<td>top</td>
<td>image</td>
<td>0</td>
</tr>
<tr>
<td>video.avi</td>
<td>1000 px</td>
<td>center</td>
<td>bottom</td>
<td>video</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Welcome!</td>
<td>center right</td>
<td>center</td>
<td>top</td>
<td>welcome text</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>
### Experiment Center

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
<th>X</th>
<th>Y</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Targets</td>
<td>target:static</td>
<td>10 %</td>
<td>center top</td>
<td>10%</td>
<td>12%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>target:linear</td>
<td>1000 px</td>
<td>center bottom</td>
<td>100</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td></td>
<td>target:sine</td>
<td>center right</td>
<td>center top</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>target:saw</td>
<td>300</td>
<td>300</td>
<td>12%</td>
<td>32%</td>
<td></td>
</tr>
</tbody>
</table>

(... table continues horizontally)

<table>
<thead>
<tr>
<th>target:shape</th>
<th>target:duration</th>
<th>target:end x</th>
<th>target:end y</th>
<th>target:ampl x</th>
<th>target:ampl y</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>4000</td>
<td>center left</td>
<td>20%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>my target.png</td>
<td>3500</td>
<td></td>
<td>20%</td>
<td>30%</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>2000</td>
<td></td>
<td></td>
<td>300</td>
<td>200</td>
</tr>
</tbody>
</table>
Defining iterations and references

Use the keywords 'Start Repeat' and 'Stop Repeat (number of iterations)' in the Name column.

The stimuli defined between a pair of 'start repeat' / 'stop repeat' will be generated multiple times according to the number of iterations set in 'stop repeat (n)'

Assigning different values for stimulus properties depending on the iteration index is done using reference sheets. Each column defines the values for a certain variable, example:

<table>
<thead>
<tr>
<th>Description of variable 1</th>
<th>Description of variable 2</th>
<th>Description of variable 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable 1 value for iteration 1</td>
<td>Variable 2 value for iteration 1</td>
<td>Variable 3 value for iteration 1</td>
</tr>
<tr>
<td>Variable 1 value for iteration 2</td>
<td>Variable 2 value for iteration 2</td>
<td>Variable 3 value for iteration 2</td>
</tr>
<tr>
<td>Variable 1 value for iteration 3</td>
<td>Variable 2 value for iteration 3</td>
<td>Variable 3 value for iteration 3</td>
</tr>
</tbody>
</table>

The stimulus definition sheet can reference a variable with the syntax #sheet[column]. Example:
### Main sheet:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Content</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Repeat</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intro</td>
<td></td>
<td>#data [A]</td>
<td>#data [B]</td>
</tr>
<tr>
<td>End Repeat (5)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 'data' sheet:

<table>
<thead>
<tr>
<th>Intro Content</th>
<th>Intro duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>intro 1</td>
<td>5000</td>
</tr>
<tr>
<td>intro 2</td>
<td>10000</td>
</tr>
<tr>
<td>intro 3</td>
<td>6000</td>
</tr>
</tbody>
</table>

### Result:

5 composite stimuli having each a single text item

- intro 1 with content 'intro 1'
- intro 2 with content 'intro 2'
- intro 3 with content 'intro 3'
- intro 4 with content 'intro 1'
- intro 5 with content 'intro 2'
A repeat block can have inner repeat blocks.

**Stimulus definition blocks**

Allows moving stimulus data blocks from the master sheet in a separate sheet, to remove clutter.

The master sheet will contain a reference to the block sheet as a placeholder with the syntax:

```
#sheet_name ex: #questions
```

**Example:**

Master sheet:
The result will be a composite stimulus 'Intro' having 2 items, an image and a video.

Note that the definition sheet can have multiple stimuli defined, while the main sheet needs only one reference to insert all of them.

Referencing a definition sheet also supports selecting a stimulus based on the current iteration index:

Example:

Master sheet:
The result will be a list of 4 composite stimuli:

- The stimuli 1 and 3 will contain an image (Intro Image) and
- the stimuli 2 and 4 will contain a video (Intro Video)

Note for definition sheets: using variable references and iterations is not supported.
6.3.8 Stimuli Settings

A stimulus is something that is presented on a monitor to the participant in front of the monitor. Experiment Center supports a broad range of stimuli types and allows combining them in one experiment. Each stimulus is represented as an element in the Application Window. While preparing the experiment, the operator can set the properties of each stimulus individually according to the experiment objective. The presentation can contain a validation, text, a question, an image, a web site, a movie, an interactive screen recording, or an external video.

⚠️ Don't use special characters for stimulus file names, such as 'ä', 'î', "Ç" or similar. Use letters A-Z, digits 0-9, or the space character only.
Add stimulus

To add stimuli to be used in your experiment proceed as follows:

1. If the experiment is locked, click to unlock.

2. Click the desired button in the top toolbar\textsuperscript{[165]}. Alternatively, you can choose the respective entry from the Insert\textsuperscript{[163]} menu.

The stimulus is added to the list of stimuli as a new element.

3. Select one or more stimuli elements to set their properties.

   The stimulus will be displayed in the preview window. The stimulus properties will be displayed in the properties window. Depending on the stimulus type, different properties are available.

4. Enter the desired values in the properties pane.

5. To undo any change, press [CTRL-Z\textsuperscript{[163]}]. Alternatively, you can choose the respective entry from the File\textsuperscript{[163]} menu. Similarly, to redo any change, press [CTRL-Y\textsuperscript{[163]}] or enter from the File\textsuperscript{[163]} menu.
It is possible to change properties for multiple stimuli elements at once. For stimuli of different type only common properties will show in the properties window. The picture below shows an example where the duration of several stimuli (that have the duration property) is set at once.
Common stimulus properties

There are properties that exist for all types of stimuli:

1. **Task**
2. **Randomization Group**
3. **LPT trigger**

Check the linked topics for a description of these features.
Delete stimulus

To remove stimuli not to be used in your experiment proceed as follows:

1. If the experiment is locked, click to unlock.
2. Select one or more stimuli in the list.
3. Press [ DEL] . Alternatively, right click the desired stimulus entry and select the Delete Object command from the context menu.
4. To undo any change, press [ CTRL- Z] . Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press [ CTRL- Y] or enter from the File menu.

Copy stimulus

To copy a stimulus in your current experiment please proceed as follows:

1. If the experiment is locked, click to unlock.
2. Select one stimulus in the list.
3. Press [ CTRL- C] . Alternatively, right click the desired stimulus entry and select the Copy Element command from the context menu.
4. Select the position where you want to add the copied stimulus
5. Press [ CTRL- V] . Alternatively, right click the desired stimulus entry and select the Paste command from the context menu.
6. To undo any change, press [ CTRL- Z] . Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press [ CTRL- Y] or enter from the File menu.

Change order of stimuli

While you are designing an experiment, you may want to change the order of stimuli. To do so, proceed as follows:
1. If the experiment is locked, click the lock icon to unlock.

2. Select an element with the mouse and drag it to the desired position in the list.

   As you move the mouse, the drop position is indicated by the blank row that moves through the list as you drag your item around.

3. To undo any change, press [CTRL-Z]. Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press [CTRL-Y] or enter from the File menu.

4. To test the changed sequence, navigate through the list of stimuli using the cursor [UP] / [DOWN] keys or navigate through the list using the arrow buttons below the preview pane:
   - Selects the previous stimulus
   - Selects the next stimulus
6.3.8.1 Calibration

Calibration is the adaptation to the current participant’s eye characteristics. During calibration, a number of targets in known screen locations are presented to the participant. The participant needs to fixate the presented targets while the position of the participant’s gaze is registered by the iView X system.

To get correct measurement results, it is vital to execute calibration before presenting your stimuli. Gaze tracking data acquired before calibration is completed successfully may be incorrect.

Insert a calibration

If you create a new experiment, the calibration is included as the first element in the list of stimuli by default. It is possible to move the calibration element to another position, for example to prepend a text message as participant information on the display.

You can also click [ ] in the list of stimuli.

Edit calibration settings

To edit the calibration settings proceed as follows:

1. Select the calibration element [ ] in the list of stimuli.
   The properties pane shows the current calibration settings. The preview pane displays the used target symbol.

2. Background Color field: Click on [ ] to open the color selection dialog, offering separate color tabs. Select the desired background color.
The selected color will also be used as frame color for all stimuli that do not fit to the full screen and if the stimulus is adjusted "transparent".

3. **Calibration method** field: The number of calibration points being used for the calibration can either be taken as a default directly as defined in iView X or can be selected here. If the connected eye tracking device doesn't support the selected calibration method then the best device specific default settings is being used instead. The options available depend on the license type:

- **Professional Packages:**
  - Fastest: 2 point calibration, Smart Binocular, Calibration speed: normal, Smart Calibration: enabled;
  - Balanced (default): 5 point calibration, Smart Tracking, Calibration speed: normal, Smart Calibration: enabled;
  - Best: 9 point, Smart Tracking, Calibration speed: normal, Smart Calibration: enabled.

- **Scientific Packages:**
  - 0, 1, 2, 5 (default), 8, 9, 13 point calibration. The other settings (calibration speed, etc.) are available as independent fields.

The supported calibration methods for the various eye tracking devices are as follows:

- **RED devices:** 2, 5, 9 point calibration and iViewX default (which is the calibration method selected in iViewX).
- HED and HiSpeed devices: 5, 9 and 13 point calibration and iViewX default.
- REDn and RED250mobile devices: 0, 1, 2, 5, 9 and 13 point calibration.

4. Calibration speed: Controls the speed of the calibration points movement. It can be Fast or Slow. Available for Scientific Packages only.

5. Target Shape (Available for Scientific Packages only)
   a) Target Shape field: This field indicates the currently used target. To change the target, click ▼ and select one of the following list entries from the drop-down list: “black circle”, “white circle”, “black cross”, “white cross”. Select "user defined" to open the Select a file dialog. Navigate to the Experiment Center program directory and select the desired bitmap graphics file (BMP, JPG, PNG, ICO, AVI or animated GIF) to be used as calibration target. Click Open.

   Here, it may occur that you cannot select user defined targets twice. In this case you need to use the direct button "Target Shape".

   b) Target Shape direct button in the preview window. Click on that button and select one of the four predefined targets or select a user defined target.

6. Target Sound field: A custom audio file (wav, mp3, wma) can be selected and is played back when the calibration target is presented to the participant. So the target sound should have an adequate length. Available for Scientific Packages only.

7. Target Animation field: This field determines if the calibration target is animated. To change the animation mode, click ▼. Select none for the default static target. Select blink for a target which is blinking twice. Select animated for a target which moves as an animation from point to point. Select animated and shrink for a target which moves as an animation and also shrinks as it reaches the fixed position. Available for Scientific Packages only.
8. **Accept Calibration Point** field: If **Stable Fixation (automatic)** is selected, the calibration proceeds automatically after a stable fixation has been recognized for each target point. The **Semi-automatic** (default) option works the same with the exception of the first point, which needs to be accepted manually by the operator or participant by pressing the space key. If the other options are selected, each calibration point must be accepted manually by pressing the space key (**Space Bar**) or any of space key or mouse click (**Mouse Click or Space Bar**). If the **Mouse Click or Space Bar** option is chosen, the participant’s mouse location will be indicated by a crosshair. The calibration point will be accepted at the time when the participant clicks on the calibration point. At the time of click, the mouse cursor needs to be positioned within 2 pixels of the center of the calibration point. Alternatively, the operator can accept the calibration point by pressing **Space Bar**.

9. **Quality check** field: Click to open a drop-down list:

   – Select **None** (default) setting to continue with the next stimulus unconditionally.

   – Select **Validation** if a validation shall be executed at the end of the calibration routine, by showing four additional points to the participant. The validation quality is then presented visually and the average deviation of the participants gaze to the validation points is shown. See the **Information on Calibration** chapter for the way the quality values are computed. The operator can decide to continue or repeat the calibration if desired. Available for Scientific Packages only.

   – Select **Auto Repeat Calibration** to run a validation and repeat the calibration automatically if the error is larger than a threshold defined in the **Auto Repeat Threshold** property, which appears when **Auto Repeat Calibration** is selected. The calibration routine will be executed until the error is below the preset threshold or continue up to three times. If after the third run the predefined threshold is not met, the experiment will be continued and the best calibration of the three calibration runs will be selected.
– Select **Quantitative Feedback** to get numerical accuracy feedback right after the calibration, based on the calibration points. This mode allows recalibration of a single point by clicking on it in the quality feedback dialog. Available for RemoteNG devices only (REDn, RED250mobile). See the **Information on Calibration** chapter for the way the quality values are computed.

10. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.


    For specific features availability please check the **Product Variants** chapter.

    **Recording of Audio with stimuli**: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see **Global Settings**). Audio recording requires a valid license of the Observation package.

After you have set the calibration continue with **selecting and setting up the stimuli**.

**Direct Button (Available for Scientific Packages only)**

**Direct Button "Target Shape"** opens the target shape selection dialog.

Please select one of the predefined calibration targets or a user defined target.
User defined targets can be static images (bmp, jpg, png) or animated targets (avi, gif).

**Direct Button "Calibrate Now"** immediately starts a calibration (if Experiment Center is connected with iView X).
6.3.8.2 Validation

Insert a validation

To insert a validation click on the list of stimuli.

Edit validation settings

To edit the validation settings proceed as follows:

1. The properties window shows the current validation settings. The preview window displays the used target symbol.

2. **Background Color** field: Click on the dropdown to open the color selection dialog, offering separate color tabs. Select the desired background color.

3. **Target Shape**
   a) **Target Shape** field: This field indicates the currently used target. To change the target, click on the dropdown and select one of the following list entries from the drop-down list: “black circle”, “white circle”, “black cross”, “white cross”. Select "user defined" to open the Select a file dialog. Navigate to the Experiment Center program directory and select the desired bitmap graphics file (BMP, JPG, PNG, ICO, AVI or animated GIF) to be used as validation target. Click Open.

   Here, it may occur that you cannot select user defined targets twice. In this case you need to use the direct button "Target Shape".

   b) **Target Shape** direct button in the preview window. Click on that button and select one of the four predefined targets or select a user defined target.

4. **Target Sound** field: A custom audio file (wav, mp3, wma) can be selected and is played back when the validation target are presented to the participant.
5. **Target Animation** field: This field determines if the validation target is animated. To change the animation mode click 🌡. Select none for the default static target. Select blink for a target which is blinking twice. Select animated for a target which moves as an animation from point to point.

6. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

7. **Accept Calibration Point** field: If Stable Fixation (automatic) is selected (default), the validation proceeds automatically after a stable fixation has been recognized for each target point. If the other options are selected, each calibration point must be accepted manually by pressing the space key (Space Bar) or any of space key or mouse click (Mouse Click or Space Bar). An exception is the first point, which needs to always be accepted manually by the operator or participant by pressing the space key. For most test persons, the automatic validation is a fast and accurate method and therefore recommended to use. If no is selected, each validation point must be accepted manually by pressing the space key.

8. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with Select a file which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected.

- and continues playing when **Continue** is selected in the next element.

- or stops when **Stop** or another file is selected in the next element.


For specific features availability please check the **Product Variants** chapter.
Mouse clicks and key presses (except recording control keys, see here [169], which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

**Recording of Audio with stimuli:** If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings [23]). Audio recording requires a valid license of the Observation package.

**Direct Button**

**Direct Button "Target Shape"** opens the target shape selection dialog. Please select one of the predefined validation targets or an user defined target.

User defined targets can be static images (bmp, jpg, png) or animated targets (avi, gif).
Direct Button "Validate Now" starts immediately a validation (if Experiment Center is connected with iView X).
6.3.8.3 Text Stimulus Element

A text stimulus is entered in a special editor window provided by Experiment Center (see Text Editor Window). The text editor allows you to edit the text content while displaying the end result visible later during the experiment ("WYSIWYG").

This is especially true if you press [F12] to toggle between full screen mode and normal mode.

Insert stimulus element

To insert a text stimulus element proceed as follows:

1. Click in the top toolbar.
   The text editor window opens.

2. Enter new text or paste it from the clipboard. Use the toolbar buttons to format the text.

3. To close the text editor, click its OK button.
In the Application Window, a new text stimulus element is added to the list of stimuli.

The Experiment Center text editor provides only basic text editing capabilities. If more formatting is required, please use a word processing program like MS WinWord or OpenOffice Writer to format your text and copy it to the Experiment Center Editor via clipboard.

**Edit stimulus element**

To edit the properties of the text stimulus element proceed as follows:

1. Select the element. You can check its design in the preview pane on the right.

2. **Duration**: In the properties window, enter the transition time in the Duration field (min. 50 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 50 ms, e.g. 50-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the [SPACE] key, the [>] key, or [F11].

3. **Source**: Change the source file name for the text stimulus. This can also be edited directly from the stimulus list from the "Source/Name" column.

4. **Background Color** field: Click on to open the color selection dialog, offering separate color tabs. Select the desired background color.

   Note: If you select "transparent", the frame color will be the color you selected in "Calibration". See also Edit calibration settings.
5. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

6. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

7. In the **Presentation Width [Pixel]** field, the presentation (rendering) of the text on the stimulus display can be limited to a smaller area than the screen width. If a value smaller than the current screen width resolution is entered, the text area is centered on the screen with left and right borders. The default value is "screen width", which means that the text is automatically rendered to the full screen resolution.

8. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.

For specific features availability please check the Product Variants chapter.

Mouse clicks and key presses (except recording control keys, see which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Change text inside of the stimulus element

If necessary, you can edit the text, e.g. to change its font size or alignment.

Direct Button "Edit"

1. Press the Edit button on top of the preview pane
2. Edit the test and/or change its properties.
3. Click OK to close the text editor window.

Direct Buttons "Add Trigger AOI" and "AOI Options..."

1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the text. The AOIs can be moved and changed in size within the text area.
2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button **AOI Options...** to customize how the trigger AOI react. The possible options are:

**Accumulated**
- Default value: disabled
- **Disabled**: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
- **Enabled**: the AOI triggers the presentation of the next stimuli when the sum of all respondent dwell times into that area is more than "Dwell time" milliseconds.

**Inverted**
- Default value: disabled
- **Disabled**: the AOI is active when looking over its area.
- **Enabled**: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.
- When Enabled, the **Include Zero Data** option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

---

**If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).**

**If the reading package is licensed, AOIs on text elements for further analysis in BeGaze are automatic generated during experiment execution.**
6.3.8.4 PDF Stimulus Element

You can use a PDF document in your experiment. The pages of the document will be displayed one after the other like a series of image stimuli. Move between the pages the same way you move between stimuli (left/right arrow keys).

**Insert stimulus element**

To insert a PDF stimulus element proceed as follows:

1. Click ![document icon](image) in the top toolbar.
   
   A document selection dialog opens.

2. Select the PDF document and click the **Open** button.
   
   In the Application Window, a new PDF stimulus element is added to the list of stimuli.

**Edit stimulus element**

To edit the properties of the PDF stimulus element proceed as follows:

1. Select the element. You can check its design in the preview pane on the right.

2. **Duration**: In the properties window, enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the [SPACE] key, the [>] key, or [F11].

3. **Fit to Screen**: Select **Yes** to display the pages in full screen mode. Note that the scaling preserves the aspect ratio of the page. Select **No** if you want to keep the page's original size.

4. **View Mode**: 

---

*2017 Version 3.7*
- Single: display one page at a time.

- Double: display two pages simultaneously, odd pages on the left, even pages on the right.

- Double Facing: display two pages facing each other like in a real printed document. If the document has a cover, it is displayed alone.

5. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

6. **Show Mouse Cursor**: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

7. **Start page**: the number of the first page to display.

8. **End page**: the number of the first page to display.

9. **Continue on Mouse Click**: Select Yes to skip to the next stimulus in the list on mouse click.

10. **Audio playback**: An audio file (wav, mp3, wma) can be loaded with Select a file which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

    - and continues playing when Continue is selected in the next element.

    - or stops when Stop or another file is selected in the next element.


    For specific features availability please check the **Product Variants** chapter.
Mouse clicks and key presses (except recording control keys, see here which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Change the PDF source document of the stimulus element
You can change the PDF source file for a PDF stimulus.

Direct Button "Select file..."
1. Press the Select file button on top of the preview pane
2. Select a new PDF file. Click Open to use the selected PDF.

Direct Buttons "Add Trigger AOI" and "AOI Options..."
1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.
2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.
3. Use the direct button AOI Options... to customize how the trigger AOI react. The possible options are:
Accumulated

- Default value: disabled
- *Disabled*: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
- *Enabled*: the AOI triggers the presentation of the next stimuli when the *sum* of all respondent dwell times into that area is more than "Dwell time" milliseconds.

Inverted

- Default value: disabled
- *Disabled*: the AOI is active when looking over its area.
- *Enabled*: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.
- When Enabled, the **Include Zero Data** option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

### If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).
6.3.8.5 Question Element

The question element adds custom questions with multiple choice and free text answers. Furthermore the answers can be assigned to participant properties (e.g. gender, age group) which allows you to use them in BeGaze for filtering. The questions are automatically rendered on the stimulus screen.

Insert stimulus element

To insert a question stimulus element proceed as follows:

1. Click in the top toolbar.

   The question editor opens.

   ![Question Setup](image-url)
2. Enter your question. Example: What is your gender?

3. Enter your answers.
   1. Press "Add answer" to add a pre-defined multiple choice answer.
   2. Press "Add free text" to add a free text field as an answer, represented by "..." in the answer list.

4. If needed, select an existing participant property (e.g. gender) from the "Assign to Participant Property" list.
   
   If the participant property doesn't exist, you can create a new participant property by pressing the button "Participant Property Editor".
   
   ! Warning! If you select an existing participant property and the entered value made by the operator differs from the entered value of the participant, the second one will overwrite the first in the BeGaze analysis.

5. In case the participant shall be able to select multiple answers from the "multiple choice selection", please check the "Allow multiple answers" checkbox. In this case, it is not possible to assign an answer to a participant property.

6. To close the question editor, click it’s OK button.

**Edit stimulus element**

To edit the properties of an image stimulus element proceed as follows:

1. Select the element. You can check it in the preview window.

2. **Name**: question name, used to identify a specific question in the experiment

3. **Background Color** field: Click on to open the color selection dialog, offering separate color tabs. Select the desired background color.

4. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.
5. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with *Select a file* which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

- and continues playing when *Continue* is selected in the next element.

- or stops when *Stop* or another file is selected in the next element.


For specific features availability please check the Product Variants chapter.

The question results are stored for all participants in the results directory in one xml and one tsv file. In addition, BeGaze is presenting them in the question template of the statistics module.

**Recording of Audio with stimuli**: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.
6.3.8.6 Image Stimulus Element

You can use a single image in your experiment as well as a series of images to perform a slideshow.

Insert stimulus element

To insert an image stimulus element proceed as follows:

1. Click ![image icon] in the top toolbar.
   The Select Image dialog opens.

2. Select the desired image from the directory list (*.bmp, *.jpg, *.png, *.wmf, or *.tif files). You can also select multiple images from the directory.

3. Click Open.
   In the Application Window, a new image stimulus element is added to the list of stimuli. If you have selected multiple images, each image is added as a separate stimulus element.

Edit stimulus element

To edit the properties of an image stimulus element proceed as follows:

1. Select the element. You can check it in the preview window on the right.

2. In the properties window, enter the transition time in the Duration field (min. 50 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 50 ms, e.g. 50-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the [ SPACE] key, the [ >] key, or [ F11].
3. In the **Fit Image to Screen** field, click to open a drop-down list. Select **Yes** to display the image in full screen mode. Note that the scaling preserves the aspect ratio of the image. Select **No** if you want to keep the image's original size. The display area not covered by the stimulus is filled with the calibration background color.

4. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

5. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

6. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.


   For specific features availability please check the **Product Variants** chapter.
Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Mouse clicks and key presses (except recording control keys, see here) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Direct Buttons "Add Trigger AOI" and "AOI Options..."

1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button AOI Options... to customize how the trigger AOI react. The possible options are:

   - Default value: disabled
   - *Disabled*: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
   - *Enabled*: the AOI triggers the presentation of the next stimuli when the sum of all respondent dwell times into that area is more than "Dwell time" milliseconds.
Inverted

- Default value: disabled
  - Disabled: the AOI is active when looking over its area.
  - Enabled: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.
  - When Enabled, the Include Zero Data option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).

6.3.8.7 Composite Stimulus Element

You can mix several image, text, movie and animated target stimuli into a single composite stimulus with this element.
**Insert stimulus element**

To insert an image stimulus element proceed as follows:

1. Click 📷 in the top toolbar.

   The **Composite Editor** opens.

   ![Composite Editor](image.png)
2. You can add several text, image, movie and animated target stimuli using the buttons at the top or by clicking on the list of stimuli.

3. Use the **Position X/Y, Width, Height** and **%/Px** columns or drag with the mouse in the preview area below the list to adjust the position of each stimulus inside the composite stimulus. There is also a **Auto-Layout** button on the right to arrange all the stimuli in a grid of equal sized cells.

4. Use the **Assign AOI** column to associate rectangular AOIs around each of the individual stimuli and make them bigger than the exact stimulus size by the value in the **AOI Padding** column. Use the **Preview AOI Padding** button on the right to see the assigned AOI shapes. The AOIs will be available instantly for later analysis in BeGaze. The name of the AOI is defined by the Name of the element in composite editor. Note: reading AOIs (character, word, sentence, paragraph) are always generated for the text stimulus elements independent of the **Assign AOI** option.

5. Use the **Full Screen** button if you need a larger editor window for better viewing of the stimulus elements.

6. You can start over with a clean list by clicking the **Delete all elements** button.

7. Click **Apply** to create the resulting stimulus.

   In the Application Window, a new composite stimulus element is added to the list of stimuli.

**Edit stimulus element**

To edit the properties of an image stimulus element proceed as follows:

1. Select the element. You can check it in the preview window on the right.

2. In the properties window you can edit the Name of the stimulus.

3. You can also select a **Background Image** to add behind all the stimulus elements in the composite stimulus, that stretches the whole size of the composite stimulus.
4. Enter the transition time in the **Duration** field (min. 50 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 50 ms, e.g. 50-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the [ SPACE] key, the [ >] key, or [ F11].

When having a movie element in the composite stimulus, the minimum allowed duration is 500 ms.

5. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

6. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

7. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.


For specific features availability please check the **Product Variants** chapter.
Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Mouse clicks and key presses (except recording control keys, see here which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Direct Buttons "Add Trigger AOI" and "AOI Options..."

1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button AOI Options... to customize how the trigger AOI react. The possible options are:

   - Default value: disabled
   - Disabled: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
   - Enabled: the AOI triggers the presentation of the next stimuli when the sum of all respondent dwell times into that area is more than "Dwell time" milliseconds.
Inverted

- Default value: disabled

- **Disabled**: the AOI is active when looking over its area.

- **Enabled**: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.

- When Enabled, the **Include Zero Data** option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).

### 6.3.8.7.1 Animated Targets

Animated target elements (shaped as a circle, cross or user defined image) can be added to the composite stimulus the same way as images, movies and text. When adding an animated target, the **Target Editor** dialog appears, allowing the customization of whether and how the target is animated.
The Target Editor allows selecting the following target types:

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Movement Path</th>
<th>Velocity</th>
<th>Cyclic</th>
<th>Movement Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>fixed position</td>
<td>-</td>
<td>-</td>
<td>Position</td>
</tr>
<tr>
<td>Linear</td>
<td>linear segment</td>
<td>constant</td>
<td>no</td>
<td>Start Position, End Position, Duration</td>
</tr>
<tr>
<td>Sinusoidal</td>
<td>linear segment</td>
<td>sinusoidal</td>
<td>yes</td>
<td>Center, Amplitude,</td>
</tr>
</tbody>
</table>
The following image shows the movement behavior in time for each type of target (same movement in time applies for both X and Y axis):

All targets can have an onset time specified in milliseconds, the **Start Time [ms]** property. For example, if the onset time is 10000, the target will appear on screen after 10 seconds. Also, there's an optional **End Time [ms]** property to specify when the target will disappear. If this is not set, the target remains visible until the end of the stimulus.
Depending on the type the target properties can be specified as follows:

- **Static**: the position in X and Y coordinates can be specified for the fixed position of the target.

- **Linear**: the X and Y coordinates for start and end positions and also the duration of the movement are configurable. The movement has constant speed. When the target reaches the end position it remains there until the set End Time or the end of the stimulus.

- **Sinusoidal**: The target movement has a speed that varies according to its sinusoidal function. The target keeps moving until the set End Time or the end of the stimulus, returning to the center position at the end of each period. The coordinates for the center position and the amplitude on X and Y (in pixels) of the target sinusoidal movement around this center position can be configured. The period in milliseconds of the sinusoidal function is also editable.

- **Saw Tooth**: has the same settings as the sinusoidal type, the only difference being that the movement speed is constant during the whole period. It returns to the center position after a period, the same as the sinusoidal type.

The target coordinates can be expressed in absolute values (pixels), percentage or predefined positions (i.e. Center Left etc). The amplitudes, where applicable, can be expressed in absolute values or percentage.

The available target shape are:

- "Circle", "Cross" : have configurable center and fill colors;

- "Custom": allows browsing for an image file that can be used as the target image.

The target size can be changed in the composite editor. The same as for the other elements in a composite stimulus, an AOI can be assigned to the target element.

Targets can be added to stimulus list templates in a similar way to the other elements of the composite stimulus. See the **Stimulus List** chapter for details on how to do this.
6.3.8.8 Web Stimulus Element

You can use a web site in your experiment. The web site can be displayed either in Microsoft Internet Explorer or Mozilla Firefox. The latest recommended version of Internet Explorer and Firefox can be found in the About Experiment Center dialog (see Web Browser Information).

For the Web stimulus availability please check the Product Variants chapter.
Insert stimulus element

To insert a web stimulus element proceed as follows:

Click 🖼️ in the top toolbar. In the Application Window, a new web stimulus element is added to the list of stimuli.

Edit stimulus element

1. In the properties window, enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500 ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the web element stops and the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the function key [ F11 ].

2. In the Web address (URL) field of the properties pane, enter the desired URL. The web stimulus browser displayed during the experiment will start with this URL.

3. Browser field. You can choose between Microsoft Internet Explorer and Mozilla Firefox (For latest approved version, consult the About Experiment Center dialog). If the selected browser is not found in the system when starting the experiment, a download link will be prompted.

4. Record Data field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

5. Full Screen field: Choose Yes to start the browser in full screen mode.

6. Disable Close Button: Choose Yes to disable the close button of the browser window.

7. In the Background Screen Recording field, click ☰ to open a drop-down list. Select Yes if a screen recording video with a fixed rate of 10 FPS (frames per second) is recorded in parallel, while the participant is operating the web stimulus browser. Please always have in mind that
screen recording requires significant processor usage and requires a two PC setup or an i7-Processor based PC/Laptop for one PC setup. Otherwise select No (default).
8. **Screenshot on Mouse Navigation**: This option is active only for Microsoft Internet Explorer: Choose *Yes* to take a screenshot when the user navigates to another address via a mouse click on a link.

9. **Browser Width [Pixel]**: Select the browser window width. The default value is "screen width", which means that the browser is rendered to the full screen width.

10. **Browser Height [Pixel]**: Select the browser window height. The default value is "screen height", which means that the browser is rendered to the full screen height.

11. **Browser Offset X [Pixel]**: Select the browser window horizontal offset. The default value is "centered", which means that the browser is horizontally centered on the screen. The value can't be more than the screen width minus the browser width set above.

12. **Browser Offset Y [Pixel]**: Select the browser window vertical offset. The default value is "centered", which means that the browser is vertically centered on the screen. The value can't be more than the screen height minus the browser height set above.

13. **Audio playback field**: An audio file (wav, mp3, wma) can be loaded with *Select a file* which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when *Continue* is selected in the next element.

   - or stops when *Stop* or another file is selected in the next element.


For specific features availability please check the **Product Variants** chapter.
Recording logic of web pages

Websites are stored individually per participant. Only one webpage image is stored following the following algorithm:

- during loading of the webpage
- when webpage is fully loaded
- a few second after the webpage is fully loaded (in case of longer lasting initialization of e.g. active content)
- when Operator presses the Print Screen button
- when leaving a website by clicking on a link in case the property "Screenshot on mouse navigation" is set.

Mouse clicks and key presses (except recording control keys, see here which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

New screenshots of the web pages will be taken for each experiment run (useful for pages with dynamic content). An option to associate a representative screenshot for the whole set of trials is available in BeGaze during results analysis.

[ F11 ] key: stops the web browsing stimulus and proceeds with the next stimulus
The web stimulus element is mainly designed to analyze visual attention for multiple users and user groups. To achieve the best possible comparison between different users, there are some limitations regarding active web content. Note that the navigation from web page to web page is also recorded in the Participant Protocol.

Recording of gaze data starts when the web site starts to load. In addition, a user message "URL completely loaded" is generated and stored in the *.idf file when the web site is completely loaded which can be analyzed together with the gaze data in BeGaze.

For more details about Mozilla Firefox see Firefox Trial creation.

!! Web standards and browsers are continuously evolving. For this reason, there can be web pages which are not displayed properly. This especially includes active content such as movie sites, online games, various Web 2.0 content, frames, incompatible HTML, or failing script code.

!! Firefox is the recommended web browser in case of very long websites being tested, due to better performance during recording.

!! Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Direct Button "Screen Recording Overlays..."

This allows the configuration of the overlays applied in the background screen recordings. For details please see the "Overlays..." button of the Screen Recording Stimulus Element.
Direct Buttons "Add Trigger AOI" and "AOI Options..."

1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button AOI Options... to customize how the trigger AOI react. The possible options are:

   - **Default value: disabled**

   - **Disabled**: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.

   - **Enabled**: the AOI triggers the presentation of the next stimuli when the sum of all respondent dwell times into that area is more than "Dwell time" milliseconds.

   - **Default value: disabled**

   - **Disabled**: the AOI is active when looking over its area.

   - **Enabled**: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.

   - When Enabled, the Include Zero Data option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.
If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).

6.3.8.9 Movie Stimulus Element

You can use a movie file in your experiment. The movie file needs to be playable with the installed Microsoft Media Player (see Supported File Formats). For the Movie stimulus availability please check the Product Variants chapter.
**Insert stimulus element**

To insert a movie/video stimulus element proceed as follows:

1. Click 🎥 in the top toolbar.

   The **Select Movie** dialog opens.

2. Select the desired movie from the directory list. You can also select multiple movies from the directory.

3. Click **Open**.

   In the Application Window, a new movie stimulus element is added to the list of stimuli. If you have selected multiple movies, each movie is added as a separate stimulus element.

   **Movies are automatically re-encoded during import if they are not stored in an optimized format.** Optimized format means that the videos can be analyzed at its best performance afterwards in BeGaze. Therefore the videos are re-encoded using the XMP4 codec with settings that allow best seek performance. It might be possible that the video quality is slightly effected after re-encoding.

   **Supported file formats (before optimization) are avi, wmv, asf, mpg, mpeg, mpe, vob, mp4, m4v, mkv, mov.** It must be ensured from the creator of the experiment that the video and audio codec which is necessary to play back the original video is installed on the Experiment Center PC.

**Edit stimulus element**

To edit the properties of a movie stimulus element proceed as follows:

1. Select the element. You can check it in the preview window on the right.
2. In the properties pane, enter the transition time in the **Duration** field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the movie stops and the next stimulus element will be presented. Enter the "manual" keyword if you want to play the movie until it’s end or proceed manually using the [ SPACE] key, the [ >] key, or [ F11]
.

3. In the **Fit Movie to Screen** field, click ▼ to open a drop-down list. Select **Yes** to display the move in full screen mode. Note that the scaling preserves the aspect ratio of the movie. Select **No** if you want to keep the movie's original size. The display area not covered by the stimulus is filled with the calibration background color.

4. **Record Data** field: If no is selected, the recoding of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

5. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

6. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.


   For specific features availability please check the **Product Variants** chapter.
Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Mouse clicks and key presses (except recording control keys, see here which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Direct Buttons "Add Trigger AOI" and "AOI Options..."

1. Use the direct button Add Trigger AOI in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button AOI Options... to customize how the trigger AOI react. The possible options are:

- Default value: disabled
- **Disabled**: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
- **Enabled**: the AOI triggers the presentation of the next stimuli when the sum of all respondent dwell times into that area is more than "Dwell time" milliseconds.
**Inverted**  
- Default value: disabled  
- *Disabled:* the AOI is active when looking over its area.  
- *Enabled:* the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.
  
- When Enabled, the **Include Zero Data** option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever any of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).

### 6.3.8.10 Screen Recording Stimulus Element

You can include a screen recording in your experiment. A screen recording is an arbitrary application that the participant can use at will. Experiment Center concurrently records a screen capture video of all actions the participant performs when operating the application.

*For the Screen Recording stimulus availability please check the [Product Variants](#) chapter.*
Insert stimulus element

To insert a screen recording stimulus element proceed as follows:

1. Click in the top toolbar.

   In the Application Window, a new screen recording stimulus element is added to the list of stimuli.

The participant uses the application during the experiment. All interactions to the application like entering text, clicking on buttons, etc. are captured from the screen and saved to a video file while concurrently monitoring the gaze position. The operator or the participant ends the application using the [ F11] key.

Note that the screen recording does not end if the participant exits the application. Using this feature, it is possible to monitor further screen interaction of the participant, such as restarting an application or a working with several applications started successively.

Note that screen recording doesn't terminate applications that are started together with screen recording when screen recording stops.

Edit stimulus element

To edit the properties of a screen recording stimulus element proceed as follows:

1. Select the element.

2. In the properties window, enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the screen recording element stops and the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the function key [ F11].
3. **Application to start** field: Click the button if you want to select another application.

4. **Arguments** field: Enter arbitrary arguments added to the application's command line. Most applications will accept arguments, such as one or more file names to be opened or a web URL to be loaded.

5. **Frames per second** field: This number determines how many frames per second are captured and encoded into the resulting capture video. Possible values range from 1 to 25 frames per second.

   ! It is not recommended to use higher values than 10 in One-PC-configurations. Note that screen recording requires a very high system load which in turn may influence the application's function, the iView X gaze tracking and can cause frame drops in the recorded video. How many frames are possible for your purposes also depends on your CPU and graphics card driver resources. For example, capturing 10 frames per second on a 1680x1050x32 display requires to capture and encode 70 Megabyte/second in realtime.

6. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

7. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with **Select a file** which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when **Continue** is selected in the next element.

   - or stops when **Stop** or another file is selected in the next element.

For specific features availability please check the Product Variants chapter.
Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

Mouse clicks and key presses (except recording control keys, see [here](#) which ones) are recorded when the properties Log Mouse Clicks and Log Key Presses are set to "Yes".

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Direct Button "Overlays..."

Press Overlays... to load the following dialog:
The dialog allows the selection of overlays applied over the screen recording video:
• **Gaze cursor (Record gaze cursor overlay)**. The appearance of the gaze cursor is configurable.

The "gaze cursor filter" filters the data used to draw the overlay in the video. This filter affects only the overlay cursor and does not influence recorded gaze data.

• **Filter Depth**: The overlay output filter reduces noise by averaging the data over a period of time. The time can be set from 0 ms to 500 ms.

• **Saccade Length**: If saccades are detected the gaze cursor filter will be switched off. The jump of the cursor will be clearly visible and not be smoothed. The minimum saccade length can be set from 0 to 500 pixels.

When the data needs to be analyzed in BeGaze, it is recommended to switch off the gaze cursor overlay or at least to switch off the "smoothing" gaze cursor filter.

• **Mouse (Record mouse overlay).**

**Direct Buttons "Add Trigger AOI" and "AOI Options..."**

1. Use the direct button **Add Trigger AOI** in the preview pane to add one or more AOI on the stimulus area. The AOIs can be moved and changed in size within the stimulus area.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default value is 1000ms.

3. Use the direct button **AOI Options...** to customize how the trigger AOI react. The possible options are:

   • **Default value: disabled**

   • **Disabled**: the AOI triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into the AOI. Looking out of the AOI resets the trigger to 0.
- **Enabled**: the AOI triggers the presentation of the next stimuli when the **sum** of all respondent dwell times into that area is more than "Dwell time" milliseconds.

- **Inverted**: Default value: disabled

- **Disabled**: the AOI is active when looking over its area.

- **Enabled**: the AOI is active when not looking over its area. The AOI will trigger according to the Accumulated options over the rest of stimulus area excluding the defined AOI area.

- When Enabled, the **Include Zero Data** option is available. If enabled, the trigger is active if the participant is not looking at the stimulus monitor or the eye tracker is unable to track the eyes.

If several Trigger AOIs are defined then the presentation of the next stimulus is triggered whenever one of the Trigger AOIs is triggered (that is: the first Trigger AOIs to match the trigger conditions forwards the presentation to the next stimulus as if it were the only Trigger AOI defined).

Please read the **System Limitations** chapter.
6.3.8.11 External Video Source Element

You can connect an external video source such as game console, TV, etc. to include it in your experiment.

Please see External Video Setup before inserting the stimulus element.

Insert stimulus element

Click in the top toolbar. In the Application Window, a new external video stimulus element is added to the list of stimuli.

Edit stimulus element

Direct Button "Video Source"

Press the Video Source button to load the following dialog.

1. Select your video source. A preview appears.
2. Your audio source will be selected automatically.

3. Press OK.

4. In the properties window enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the screen recording element stops and the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the function key [ F11 ].

5. Choose whether you want to Record Data or not.

6. Audio Playback field: An audio file (wav, mp3, wma) can be loaded with Select a file which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when Continue is selected in the next element.

   - or stops when Stop or another file is selected in the next element.

7. LPT trigger, Task, Randomization Group, Annotation Triggers and Stimulus Conditions: check links for detailed descriptions.

For specific features availability please check the Product Variants chapter.
Direct Button "Gaze Cursor"

Press the Gaze Cursor button to load the following dialog.
1. Record gaze cursor overlay.

2. Use gaze cursor filter.

   The "gaze cursor filter" filters the data used to draw the overlay in the video. This filter affects only the overlay cursor and does not influence recorded gaze data.

   Filter Depth: The overlay output filter reduces noise by averaging the data over a period of time. The time can be set from 0 ms to 500 ms.

   Saccade Length: If saccades are detected the gaze cursor filter will be switched off. The jump of the cursor will be clearly visible and not be smoothed. The minimum saccade length can be set from 0 to 500 pixels.

   When the data needs to be analyzed in BeGaze, it is recommended to switch off the gaze cursor overlay or at least to switch off the "smoothing" gaze cursor filter.
6.3.8.12 External Scene Camera Element

You can present a real world stimulus using a camera to capture its image.

**Insert stimulus element**

Click in the top toolbar.

The **External Scene Camera source dialog** is presented:

In case, the system does not recognize the external scene camera, please verify that the camera is not been in use from other software or is selected as User camera in Experiment Center. In this case, uncheck "Record User Camera" in the **Global Settings** dialogue of Experiment Center.
1. Select the desired connected camera from the Video Source selection. A preview window is showing the video of the currently selected camera. The config button is opening the camera specific settings dialog (please refer to user manual of the selected camera).

Use the Resolution list to select the desired video size.

Activate Record user sound and select an audio input device from the Audio Source selection in order to add audio recording to the webcam video. Audio recording without video recording is not possible.

2. Click OK. In the Application Window, a new External Scene Camera stimulus element is added to the list of stimuli.

3. The preview of the External Scene Camera scene is displayed:

4. The calibration area is marked with a yellow rectangle. It can be resized using the mouse to match as close as possible the calibration paper size.

5. The calibration points can be moved using the mouse to match the calibrations points drawn on the calibration paper.

6. The calibration point can be reset to their default positions by pressing the Reset points button.
**Edit stimulus element**

**Direct Button "Video Source".**

The External Scene Camera video source dialog is presented and you can edit the camera hardware settings.
Direct Button "Gaze Cursor".

Press the Gaze Cursor button to load the following dialog.

1. Record gaze cursor overlay.
2. Use gaze cursor filter.

The "gaze cursor filter" filters the data used to draw the overlay in the video. This filter affects only the overlay cursor and does not influence recorded gaze data.
Filter Depth: The overlay output filter reduces noise by averaging the data over a period of time. The time can be set from 0 ms to 500 ms.

Saccade Length: If saccades are detected the gaze cursor filter will be switched off. The jump of the cursor will be clearly visible and not be smoothed. The minimum saccade length can be set from 0 to 500 pixels.

For specific features availability please check the Product Variants chapter.

When the data needs to be analyzed in BeGaze, it is recommended to switch off the gaze cursor overlay or at least to switch off the "smoothing" gaze cursor filter.

Direct Button "RED operation mode"

The External Scene Camera stimulus is using the RED in standalone mode. The Edit RED mode dialog is presented after pressing this button. A default standalone mode is created automatically if there's no existing standalone mode available.

To customize the RED stand-alone mode:

- Enter the dimensions of the paper sheet you use for calibration in the screen dimensions boxes. (cm)

- Enter all other values according to your stand-alone setup.

- To review if the profile fits, place a test person in front of the RED and check if the eyes are in the middle of the tracking monitor. If this is not the case, correct the distance RED to floor and the RED inclination angle and correct the parameters in the profile.

- Test your experiment once and check if there is a stable tracking over the whole stimulus area.
Property Editor

Record Data Controls if any data gets recorded while the stimulus is presented.

Calibration Method The number of calibration points being used for the calibration. It can be 2, 5 or 9 Point calibration.

Calibration Speed Controls the speed of the calibration points movement. It can be Fast or Slow.

Accept Calibration Point Accept calibration manually by pressing the space key or automatically when a stable fixation is detected.

Audio Playback An audio file (wav, mp3, wma) can be loaded with Select a file which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected - and continues playing when Continue is selected in the next element.

- or stops when Stop or another file is selected in the next element.

LPT trigger, Task, Randomization Group, Annotation Triggers and Stimulus Conditions: check links for detailed descriptions.

6.3.9 Randomization - Groups and Duration

The following randomizations options are available

- Randomization of the presentation order of the stimuli
- Randomization of the presentation time for each stimulus
For the Randomization feature availability please check the Product Variants chapter.
Randomization Groups

You can combine multiple stimuli in a so-called randomization group. These stimuli are presented in a random order in an experiment run and because of this the order changes for each run.

Randomization groups can be mixed up within the stimuli arrangement. While stimuli which are combined in a group are presented in a random order, the group position itself in the overall sequence of stimuli is absolute. It is possible to use one or more randomization groups in an experiment and also to cascade them.

Example:

The illustration shows the stimuli order of an experiment with five randomization groups. The order of stimuli presentation may be:

<table>
<thead>
<tr>
<th>First run</th>
<th>Second run</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text 1 (group 1)</td>
<td>Text 2 (group 1)</td>
</tr>
</tbody>
</table>

![Diagram of stimuli order]
A stimulus which is not allocated to a randomization group will be presented at that position where it is placed in the stimuli sequence. In the example above, this is the case for the “Text 3” element.

**Combine stimuli in a randomization group**

To add a stimulus to a randomization group proceed as follows:

1. If the experiment is locked, click to unlock.
2. Select the appropriate stimulus element in the list of stimuli.
3. Enter a group name (a number or a text) in the Random Group column. If you have already assigned group names within the experiment, you can alternatively click the button and select the desired group from the drop-down list.

The Participant Protocol contains the sequence and time stamps of the randomized stimuli for each run.

**Combine multiple stimuli and randomize them as a unit**
Multiple stimuli can be "glued" together and treated as one unit within the randomization group and are randomized as a unit.

Example:

There is a randomization group "Group-1" with 4 elements/units defined. The image elements are "glued" to the text element and treated as one unit.

The randomization is applied to the 4 units.

<table>
<thead>
<tr>
<th>Type</th>
<th>Source</th>
<th>Duration [ms]</th>
<th>Fit to Screen</th>
<th>Record Data</th>
<th>Random Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>RichText2.rtf</td>
<td>manual</td>
<td></td>
<td></td>
<td>Group-1</td>
</tr>
<tr>
<td>Image</td>
<td>image01.bmp</td>
<td>4000-8000</td>
<td>X</td>
<td>X</td>
<td>with previous</td>
</tr>
<tr>
<td>Text</td>
<td>RichText3.rtf</td>
<td>manual</td>
<td></td>
<td></td>
<td>Group-1</td>
</tr>
<tr>
<td>Image</td>
<td>image02.bmp</td>
<td>4000-8000</td>
<td>X</td>
<td>X</td>
<td>with previous</td>
</tr>
<tr>
<td>Text</td>
<td>RichText4.rtf</td>
<td>manual</td>
<td></td>
<td></td>
<td>Group-1</td>
</tr>
<tr>
<td>Image</td>
<td>image03.bmp</td>
<td>4000-8000</td>
<td>X</td>
<td>X</td>
<td>with previous</td>
</tr>
<tr>
<td>Text</td>
<td>RichText5.rtf</td>
<td>manual</td>
<td></td>
<td></td>
<td>Group-1</td>
</tr>
<tr>
<td>Image</td>
<td>image04.bmp</td>
<td>4000-8000</td>
<td>X</td>
<td>X</td>
<td>with previous</td>
</tr>
</tbody>
</table>

If you move a single stimulus in a different position in the list, the rest of its randomization group will remain in the previous position. If the moved stimulus is not adjacent to its group anymore then it will form its own separate group (even if it still has the previous group's name). To move a whole group together, all the stimuli from the group must be selected before dragging them in the list.

Randomization of Duration

The duration time of stimuli (where applicable) can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the given limits.
6.3.10 Tasks

Task based experiment design recording is a standard methodology in usability and psychology. Each element/stimulus in the experiment can be assigned to a task and you can design your experiment with as many tasks as you want. If no task is entered, the task based design is ignored and the stimulus always been presented.

When recording starts the operator decides which tasks have to be performed for each participant. The other tasks are skipped during that recording. The results are automatically collected and assigned by task in BeGaze.

Task definition and assignment

To define new tasks just type a new task name in the Task column of the stimulus list. After typing a new task name the name will be available for selection when clicking the drop down arrow in the Task column. You can assign a stimulus to any previously defined tasks or to no task, by leaving the field empty, if you want it always to be executed.
Task based execution

When starting a recording with tasks defined the participant information dialog comes up with an extra task related area at the bottom.

![Participant Information Dialog]

You can decide which tasks (stimulus sets) to run for this participant by checking the respective boxes in the task list. To select or unselect all the tasks toggle the Select all checkbox above the list.
6.3.11 Participant Properties

For use in the BeGaze application, you can define individual participant “group” parameters for the experiment. These parameters are entered as participant properties and serve as additional information to your experiment. Useful properties may be “Age” and “Gender”. The participant properties are stored as meta information in a separate file written to the experiment’s results directory.

Add participant property

To add new participant properties proceed as follows:

1. In the Extras menu, select the Participant Property Editor command. The Participant Property Editor dialog opens.

2. Click Add.

3. Edit the property name in the new text field that appeared.

4. Repeat for all the properties to be added.
When you start a new experiment, the Please enter participant information dialog opens where you can enter the individual participant's data (see Starting New Participant).

⚠️ If you select an existing participant property and the entered value made by the operator differs from the entered value of the participant, the second one will overwrite the first in the BeGaze analysis.

Delete participant property

To delete participant properties proceed as follows:

1. In the Extras menu, select the Participant Property Editor command.
   
   The Participant Property Editor dialog opens. The Property Name list displays the already defined properties.

2. Select the property you want to delete.

3. Click Delete.
6.3.12 Annotations

Annotations can be used during recording for coding user specific behaviour.

**Required system setup for adding annotations during experiment run**

A system setup with two keyboards and two monitors is required to use the annotation capabilities.

One keyboard is for the use of the participant, the second keyboard is for the use of the operator.

The keyboards are detected automatically when the recording starts.

⚠️ Please note that the keyboard with which you enter the participants' properties will be detected as keyboard for the use of the operator.

Except for the recording control keys, both keyboards are working independently. The participant can use the keyboard as normal, e.g. in order to perform a Web task, while the operator can use the keyboard to generate and edit annotations during runtime. The complete annotation handling for the operator can be done only by using the keyboard without using the mouse.

The recording control keys on both keyboards can still be used to control the experiment flow.

ℹ️ Experiment Center must be visible on the operator monitor.

For automatically triggering annotations when a stimulus is played, there are no special setup requirements.
Define Annotations

Annotations can be defined in the Annotation Editor... that can be found under the Extras menu.
A set of annotation definitions is stored together with the current open experiment and with each recorder participant in the experiment results.

**Add Annotation Definition**

- Click **+ Add new definition** in the top area to create a new line in the list.
- Type a **Name** for the annotation definition (this is a mandatory field).
- An **ID** and **Color** are assigned automatically. You can modify the color.
- Optionally type a **Description** for the definition.
- Select the annotation **Type**: either **Instant** where the annotation is added at a specific point in time or several interval types where the annotation also has a duration. The interval types can be: **Manual On/Off** where adding the annotation once during recording start the interval and adding it again ends it, **Fixed duration** which adds annotations of fixed duration or **Until same tag** where the annotation interval ends when the next annotation whose definition contains a common tag with the definition of the current annotation is encountered.
- **Duration**: shows when interval annotations end respective to their onset and allows setting the interval duration when **Fixed duration** is selected for the type.
- **Tags**: edit and associate a number of text tags to the annotation definitions which can be used to filter the definitions later. If the **Until same tag** type is set these tags are used for determining the annotation interval duration. Clicking **+Edit** in the Tags field show an editor for tags, similar to the one for definitions, where they can be added and removed and a **Name** and optional **Description** can be set.
Delete Annotation Definition

- Right click an entry in the list and click Remove.
- Or select an entry and press the Del key.

Save Annotation definitions

Definitions are saved automatically when pressing the OK button. By pressing the Export button, the current set of definitions can be saved (exported) as a xml file in order to use them later on in other experiments as well.

Load Annotation definitions

Press the Import button to load a previously exported set of definitions. The current list will be overwritten.

Add annotation to a stimulus

Any defined annotation can be added to a stimulus, so that the annotation will be set relative to the stimulus onset (the time when the stimulus is shown to the participant).
For the Annotation Triggers availability please check the Product Variants chapter.

In order to add an annotation to a stimulus, select Edit... in the property Annotation Trigger in the property grid. This opens the Annotation Editor with all defined annotations. Select the annotations that should be added to the stimulus and click the Add to Stimulus button. This adds the annotations to all stimuli listed in the Annotations Triggers for ... list. The added annotations will appear in the lower half of the annotation editor, and the onset and offset can be edited.

It is possible to assign annotations to multiple stimuli at once. For this you need to select the stimuli in the stimuli list, and click Edit... in the Annotation Trigger in the property grid. The annotations triggered by a stimulus will appear in the property grid next to Annotation Trigger.
Use annotations during runtime

During runtime, the operator can "fire" annotations in realtime by pressing the "0" key on the operator keyboard. This opens the annotation browser, where the operator can select an annotation and confirm the selection by pressing "Enter". The selected annotation will be added to the participant recording at the time when "0" was initially pressed.

The annotation browser allows the operator to select an annotation by using the arrow keys or filter the list first by doing a free text search in the search bar above the list. This search will show definitions that contain all the typed words in any of the ID, Name, Description or Tags fields.

If you type something in the search field that doesn't match any existing definition you can still add what you typed by pressing Enter and a new definition will be added using the typed text as its Name.

Annotations in BeGaze

BeGaze automatically reads the annotations and their definitions and shows them in the player control.

BeGaze provides functionality similar to the one in Experiment Center for defining and adding annotations and uses them in various analyses.

Please refer to the BeGaze user manual for further information.
6.3.13 Stimulus Conditions

Stimulus Conditions can be defined and associated to the stimuli in the experiment (similar to adding participant properties to participants).

For the Stimulus Conditions availability please check the Product Variants chapter.

You can edit the stimulus condition names and values by going to the Extras menu and selecting Stimulus Conditions Editor....

In the left column you can define stimulus conditions and in the right column you can define several values for each condition and also select the default value for that condition. This default value will be used for all the stimuli that don't have a specific value set in the Stimulus Conditions property of the specific stimulus.

When setting a condition value for a stimulus you get a drop down list with all the values defined for that condition. If you need more values you need
to go back to the editor, either from the menu or from the stimulus condition Edit... button on the right of the property in the property grid.

You can also export the currently defined conditions by pressing Export or load back previously saved conditions with the Import button.

### 6.3.14 LPT Trigger

The LPT trigger can be used to signal stimulus presentation events like start time or end time.

**LPT trigger settings**

The LPT trigger settings are accessible for each individual stimulus via the property editor.

For the LPT trigger feature availability please check the Product Variants chapter.
LPT Trigger  This property enables / disables the LPT trigger. The possible settings are:

- **No**  . The LPT trigger is inactive
- **Stimulus Start**  . The trigger is fired when the stimulus is presented on the screen.
- **Stimulus End**  . The trigger is fired when the stimulus presentation ends.

Trigger Port  The system address of the LPT port. The value has hexadecimal format with default value 378₁₆ (LPT1). The port number can be found by going to Device Manager -> Ports -> [desired port] and then right click, select Properties, go to Resources tab and use the first value from the I/O Range item.

Trigger Duration (ms)  The duration in milliseconds of the trigger. While the trigger is active, the value of the LPT port is the one specified in the Trigger Value setting. When the trigger is inactive, the value is 0.

Trigger Value  The value sent on the LPT data port while the trigger is active. The value is decimal with the maximum value of 255.

Trigger Message to IDF  If this value is not empty, a remark message is sent to iView X with the given text.
**Emotiv EEG Data**

EEG data from participants can be recorded in sync with the eye data using the Emotiv EEG neuroheadset hardware. For more information on the Emotiv EEG neuroheadset device please see: [http://www.emotiv.com/store/hardware/epoc-bci-eeg/developer-neuroheadset/](http://www.emotiv.com/store/hardware/epoc-bci-eeg/developer-neuroheadset/). Configuring and using it in Experiment Center is described below.

**Prerequisites**

1. Emotiv EEG neuroheadset (For more information on the Emotiv EEG neuroheadset device see: [http://www.emotiv.com/eeg/](http://www.emotiv.com/eeg/))

2. Emotiv EEG module for ExperimentSuite 360°
Step-by-step setup

Make sure neuroheadset is charged. Insert Emotiv-USB dongle into measurement PC. Turn on the headset. The LED on the Emotiv-Dongle should now be flickering rapidly.

Global settings

Activate headset in Experiment Center by switching on the checkbox Enable Emotiv EEG Neuroheadset in the Global Settings -> Advanced dialog. If disabled, no eMotiv EEG / detections suite data is shown and recorded.

Preview of EEG headset activity

There are three tabs available to monitor the Emotiv EEG neuroheadset system in the property area displayed in the lower right of the Application Window. Note that the tabs are displayed only if the Emotiv EEG neuroheadset system is connected and enabled (see Global Settings).

1. A head visualization, with the corresponding electrode positions, electrode label and signal quality. The signal quality is represented with these colors:
   - No signal: black
   - Very poor: red
   - Poor: orange
   - Fair: yellow
   - Good: green
All positions should show as green. Consult the Emotiv EEG neuroheadset manual for in-depth advice on positioning of the neuroheadset.

2. A time progressing visualization of eMotiv Affectiv™ data values (5 channels of data). The legend describes these displayed data channels. Each channel has a on/off switch for displaying or not the signal in the timeline. Dashed axes are drawn for low, medium and high signal values, representing a value between 0 (low) and 1 (high).
3. A time progressing visualization of raw electrode values (14 channels). The X values represent time and the Y values represent the specific channel value. Each channel has a label and an on/off switch and is drawn in a different color. Controls are available for:

- DC offset correction: when applied, the reference value for each channel becomes its moving average over 5 sec (the moving average becomes the mid label Y position). The new reference value remains like this until next time the option is applied.

- Channel amplitude scaling.

- DC offset removal / noise removal filters.

The settings modified in the available controls are saved and restored on the next application startup. If the headset is unavailable, the tabs are not visible.
**Recording data**

While the Emotiv EEG neuroheadset is active during eye data recording, the system will record data provided from eMotiv synchronized with the eye tracking data.

The following Emotiv EEG neuroheadset data are recorded: Affectiv (emotions) and Raw (raw electrode data).
6.4 Running Experiments

6.4.1 User Interface

6.4.1.1 Application Window

Experiment Center features a user-friendly intuitive interface. All steps for preparing, testing and running an experiment are executed in the Application Window. In the following you find a description of its three working areas.

- At top: Experiment preparation and control area
- In the middle: Experiment setting and preview area
- At bottom: Experiment execution area

Top: Experiment preparation and control area
This working area comprises the main menu and the top toolbar. Use the top toolbar buttons and the main menu entries to prepare your experiment and to control it. For detailed information please refer to the help topics entitled Toolbars and Menu Commands.

The title bar indicates the program name.

**Middle: Experiment setting and preview area**

In this area the experiment settings are reported. On the left, the list of elements used as stimuli is presented in a single pane.

On the upper right of this area, the preview pane is located. This pane shows a preview of a stimulus selected in the list of stimuli. Below the preview pane, navigation arrows allow you to display the previous (arrow left) or the next (arrow right) stimulus. While running experiments, this area also shows the current stimulus together with the participant's online gaze cursor.

On the lower right you find the properties area which shows information on a selected stimulus element. While running experiments using the RED gaze tracking device, this area can be switched to the tab showing the RED Tracking Monitor. When a user camera is selected, this area can be switched to the tab showing the user camera video.

**Bottom: Experiment execution area**

This area serves to configure and run the experiment. Use the buttons in this area to test the experiment (so-called "dry run") and to execute it. Moreover, you can export the experiment results to the BeGaze program for further analysis. For detailed information please refer to the help topic entitled Toolbars. For information on how to run experiments please refer to the help book entitled Step-by-step Instructions.
Experiment Center can be operated with separate monitors for the operator and the participant (see Double Monitor Settings). In this case the operator has to select and identify the appropriate monitor where the stimuli are presented to the participant. For this, the experiment execution area contains the Select Stimulus Monitor drop-down list and the corresponding Identify command. For more information on operating modes please refer to the topic entitled Basic Operation.

6.4.1.2 Toolbars

Top toolbar

The toolbar is at the top of the Experiment Center Application Window. It gives you short-cuts to important features to prepare and set up an experiment. The top toolbar consists of three units. Here is an overview of the buttons and what they are for:

**Experiment storage**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>Creates a new experiment</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Opens an existing experiment</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Saves the experiment with given name</td>
</tr>
</tbody>
</table>

**Experiment elements selection**
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td>Adds calibration entry into the list of stimuli</td>
</tr>
<tr>
<td>Validation</td>
<td>Adds validation to the list</td>
</tr>
<tr>
<td>Text</td>
<td>Adds text stimulus element</td>
</tr>
<tr>
<td>PDF</td>
<td>Adds a PDF stimulus element</td>
</tr>
<tr>
<td>Question</td>
<td>Adds a question element</td>
</tr>
<tr>
<td>Image</td>
<td>Adds image stimulus element (/*.bmp, *.jpg, *.png, *.wmf, or *.tif file)</td>
</tr>
<tr>
<td>Composite</td>
<td>Adds a composite stimulus element (image, text, movie)</td>
</tr>
<tr>
<td>Web</td>
<td>Adds web stimulus element (URL)</td>
</tr>
<tr>
<td>Movie</td>
<td>Adds movie stimulus element (/*.avi file)</td>
</tr>
<tr>
<td>Screen Recording</td>
<td>Adds screen recording stimulus element</td>
</tr>
<tr>
<td>External Video</td>
<td>Adds external videos sources as stimulus element</td>
</tr>
<tr>
<td>External Scene Camera</td>
<td>Adds External Scene Camera stimulus element</td>
</tr>
</tbody>
</table>

**Experiment control**
Button | Function
---|---
Unlocked | Locks the experiment so that the current settings cannot be changed accidentally. The buttons of the experiment elements section are disabled.
Locked | Unlock the experiment so that the current settings can be changed.
Connected / Disconnected | Indicates whether or not Experiment Center is connected with iView X. Click this button to open the Global Settings dialog.

**Bottom toolbar**

On the bottom of the Application Window, you find commands to run an experiment and export experiment data. To perform these actions, use the following buttons:
### Button Function

- **Identify**: Identifies the current stimulus monitor
- **Dry Run**: Runs experiment for test purposes (without calibration and recording)
- **Record**: Starts the trial to show stimuli while recording the participant’s gaze position
- **Stop**: Stops a running trial - same as the [F12] function key

- **BeGaze**: Automatically creates or updates the experiment in BeGaze – which is opened for analysis. This button is enabled if BeGaze is currently not running and there are results available for the loaded experiment.

On the bottom toolbar, you also find the Select Stimulus Monitor drop-down list. This menu is necessary to select the monitor in dual screen mode (see Double Monitor Settings).

#### 6.4.1.3 Menu Commands

The Experiment Center software includes the following menu entries:

**File menu**

- **New**: Creates a new experiment
  
  ([Ctrl] + [N])

- **Open**: Opens an existing experiment
  
  ([Ctrl] + [O])

- **Save**: Saves the experiment with given name
  
  ([Ctrl] + [S])

- **Save as…**: Saves the experiment with new name
Experiment Center

File menu

New
Creates a new experiment
([Ctrl + N])

Open
Opens an existing experiment
([Ctrl + O])

Rename Experiment...
Renames an experiment from the database

Delete Experiments...
Removes one or more experiments from the database

Import
Imports experiments (*.zep - file) or results (*.zrs - file)

Export
Exports experiments (*.zep - file) or results (*.zrs - file)

Recent Experiments
List of recently used experiments

Quit
Quits program
([Alt + F4])

Edit menu

Undo
Undoes the last change ([Ctrl + Z])

Redo
Redoes the last change ([Ctrl + Y])

Copy
Copies an element ([Ctrl + C])

Paste
Pastes an element ([Ctrl + V])
Insert menu  Function
Calibration  Adds calibration entry into the list of stimuli
Validation  Adds validation entry
Text  Adds text (plain text) stimulus element
       ([ Ctrl + T ])
PDF  Adds PDF stimulus element
       ([ Ctrl + T ])
Question  Adds a question as stimulus element
       ([ Ctrl - Q ])
Image  Adds image stimulus element
       (e.g. *.jpg or *.bmp file)
       ([ Ctrl + I ])
Composite  Adds composite stimulus element
       ([ Ctrl + U ])
Web  Adds web stimulus element (URL)
       ([ Ctrl + W ])
Movie  Adds movie stimulus element
       (e.g. *.avi or *.mpg file)
       ([ Ctrl + M ])
Screen Recording  Adds screen recording stimulus element
       ([ Ctrl + R ])
External Video  Adds external video source as stimulus element
       ([ Ctrl + E ])
External Scene Camera  Adds external camera source as stimulus element
### Extras menu

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Calibration</td>
</tr>
<tr>
<td>Runs calibration outside of experiment</td>
</tr>
<tr>
<td>Dry Run Experiment</td>
</tr>
<tr>
<td>Runs experiment for test purposes (without calibration and recording)</td>
</tr>
<tr>
<td>([ F9 ] )</td>
</tr>
<tr>
<td>Global Settings</td>
</tr>
<tr>
<td>Opens the <a href="#">Global Settings</a> dialog</td>
</tr>
<tr>
<td>Participant Property Editor</td>
</tr>
<tr>
<td>Opens the <a href="#">Participant Properties</a> dialog</td>
</tr>
<tr>
<td>Annotation Editor</td>
</tr>
<tr>
<td>Opens the <a href="#">Annotation Editor</a> dialog</td>
</tr>
<tr>
<td>Stimulus Conditions Editor</td>
</tr>
<tr>
<td>Opens the <a href="#">Stimulus Conditions Editor</a> dialog</td>
</tr>
<tr>
<td>RED Operation Mode</td>
</tr>
<tr>
<td>Opens the <a href="#">RED Operation Mode</a> dialog</td>
</tr>
</tbody>
</table>

### ? (Help) menu

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
</tr>
<tr>
<td>Opens the Online Help ([ F1 ] )</td>
</tr>
<tr>
<td>Check for Updates</td>
</tr>
<tr>
<td>Check online for updates to Experiment Suite 360°</td>
</tr>
<tr>
<td>About</td>
</tr>
<tr>
<td>Shows details about the currently licensed version of Experiment Center as well as the installed and latest approved version of Internet Explorer and Firefox</td>
</tr>
</tbody>
</table>
6.4.1.4 Keys Overview

Several functions of Experiment Center can be executed using keyboard commands. The following tables give you an overview.

Keyboard commands while editing an experiment

Press [...] key to …
[ CTRL] + [ N] create a new experiment.
[ CTRL] + [ O] open an experiment.
[ CTRL] + [ S] save the experiment.
[ DEL] delete a selected stimulus element from the list of stimuli.
[ CTRL] + [ C] copy a stimulus element.
[ CTRL] + [ V] paste a stimulus element.
[ CTRL] + [ T] insert a new text stimulus.
[ CTRL] + [ P] insert a new PDF stimulus.
[ CTRL] + [ Q] insert a new question stimulus.
[ CTRL] + [ I ] insert a new image stimulus.
[ CTRL] + [ W] insert a new web stimulus.
[ CTRL] + [ M] insert a new movie stimulus.
[ CTRL] + [ R] insert a new screen recording stimulus.
[ CTRL] + [ E] insert a new external video source as stimulus.
[ UP] / [ DOWN] move the cursor in the list of stimuli up and down.
[ TAB] change the focus to the next screen control.
[ SHI FT] + [ TAB] change the focus to the previous screen control.
[ F9] execute a dry run.
[ F10] start the experiment.
[ F1] open help.
[ F12] switch to full screen mode in text editor (text stimulus).

**Keyboard commands during calibration**

Press [...] key to …
[ SPACE] accept target fixation during calibration. The next stimulus will be presented to the participant.
[ >] accept target fixation during calibration. The next stimulus will be presented to the participant.
[ F11] end the calibration and proceed to the next stimulus.
[ F12] stop the execution of experiment if calibration is inaccurate.
[ <] repeat calibration.

**Keyboard commands while running an experiment**

Press [...] key to …
[ F5] run a calibration on demand.
[ F8] run a validation on demand.
[ F11] end the current stimulus presentation and proceed to the next one.
[ F12] stop the experiment and interrupt the presentation of stimuli (except Web and Screen Recording stimuli).
[ SPACE] to present the next stimulus element to the participant (except Web and Screen Recording stimuli).

[ >] to present the next stimulus element to the participant (except Web and Screen Recording stimuli).

[ <] to present the previous stimulus element to the participant.

You can also select any menu command by pressing the [ ALT] key together with the underlined menu hot key. For example the [ ALT ] + [ F] keyboard combination will open the File menu while a subsequent [ ALT ] + [ A] selects the File: Save as... menu command.

### 6.4.1.5 Text Editor Window

To insert and edit text stimulus elements, Experiment Center features a special Text Editor. This editor opens in a new window automatically when you have inserted or selected a text stimulus element in the list of stimuli.

Cut Cuts the marked text.

Copy Copies the marked text.

Paste Pastes a cut or copied text.

Undo Undoes the last step.

Redo Redoes the last step.

[Font] Font selection Changes the font family of the currently marked text.
[Size]  Size selection  Changes the font size of the currently marked text.

[bold]  Formats marked text bold. A repeated click on the button cancels the formatting.

[Italic]  Formats marked text italic. A repeated click on the button cancels the formatting.

[Underline]  Underlines marked text. A repeated click on the button cancels the formatting.

Bullets  Adds bullets to the selected paragraph. A repeated click on the button cancels the formatting.

Numbering  Numbers the selected paragraph. After a line break the next paragraph will be numbered consecutively. A repeated click on the button cancels the formatting.

Align left  Formats the selected paragraph left-aligned.

Align Center  Centers the selected paragraph.

Align Right  Formats the selected paragraph right-aligned.

Align Justify  Justifies the selected paragraph.

Increase indent  Increases the left indent of the selected paragraph.

Decrease indent  Decreases the left indent of the selected paragraph.

[Color]  text color  Sets the color of the text.

Full Page View  When active, the text editing area is scaled to fit the editor window, otherwise it has the size of the stimulus monitor and scrollbars are available for navigation.
6.4.2  Dry Running an Experiment

The dry run of an experiment allows the operator to check the experiment settings before it is used. The dry run is a test scenario evaluation – without calibration and recording.

Prerequisites

Before you start the dry run, ensure that

- the appropriate experiment is loaded,
- the stimuli properties are set properly.

Dry run experiment

To execute the dry run proceed as follows:

1. Ensure that the experiment is locked. If it is unlocked, click to lock.

2. If you want to display the visual stimulus on a second monitor, select the desired monitor in the Select Stimulus Monitor drop-down list (see Double Monitor Settings).

3. Click in the bottom toolbar.

   The experiment dry run starts. Calibration is skipped and nothing is recorded.

4. Press [F12] to stop the dry run at any time or click .
6.4.3 Running an Experiment

Prerequisites

Before you start recording, ensure that

- the appropriate experiment is loaded (see Loading and Changing an Experiment),
- the calibration properties are set (see Setting Calibration),
- the required stimuli are included (see Setting Stimuli),
- the desired participant properties are defined (see Participant Properties),
- the participant is seated directly in front of the stimulus PC monitor,
- the eye tracking system (iView X) is started and properly connected (see Global Settings),
- and for a double monitor setup, the desired stimulus monitor is attached and switched on (see Double Monitor Settings).

Main steps

If all prerequisites are met, a typical recording is executed with these steps:

1. Start the recording for a new participant
2. Run the calibration
3. Present stimuli
4. End the recording
6.4.3.1 RED participant placement

If the RED4 or RED/RED250 (Remote Eye tracking Device) is used, the operator controls the placement of the participant using the RED Tracking Monitor.

To view the RED Tracking Monitor, switch to the RED Tracking Monitor tab which is available in the property area displayed in the lower right of the Application Window. Note that the tab control is displayed only if Experiment Center is connected to iView X (see Global Settings).

The operator can double click on the tracking monitor tab in order to present the same view also to the participant on the stimulus monitor.
As a first step, the physical position of the participant is verified using the RED Tracking Monitor calibration display:

- If the eyes are tracked by the system, two white eye ellipses are visible in the scene image. If tracking is lost, the white dots disappear from the scene image.

- If the participant sits too far away from the screen, this arrow indicates that he or she should move closer.

- If the participant sits too close to the screen, this arrow indicates that he or she should increase the distance to the screen.

Other arrows direct the participant to center his or her head in front of the monitor. The participant sits perfectly if all arrows have vanished.
6.4.3.2 Starting New Participant

To start a gaze position recording for a new participant proceed as follows:

1. Ensure that the experiment is locked (lock icon). Otherwise, click to lock.

2. Ensure that iView X is connected (plug icon). Otherwise, click to open the Global Settings dialog in order to reconnect.

3. If you want to display the visual stimulus on a second monitor, select the desired monitor in the Select Stimulus Monitor drop-down list or by pressing the [F9] key. Click the Identify button to verify the double monitor setup. The participant should be placed in front of the monitor now identified by a large 2 (Stimulus Monitor) text display.

4. Click or press the [F10] key.

The Please enter participant information dialog opens.

The participant code is preselected with "P" followed by an increasing number and it is checked that no duplicates are used within one experiment.
If the entered value made by the operator differs from the entered value of the participant later on, the second one will overwrite the first in the BeGaze analysis.

5. Enter the mandatory Participant code. Note that this code is used to build the file name used to store the experiment results for the current trial. Do not use characters not valid for file names, such as “/”, “\”, “:”, “|”, or “<”. Use letters A-Z, digits 0-9, or the space character instead.

6. You may enter a short description for the participant in the Description field. Note that it is possible to add customized input fields to the participant information dialog (see Participant Properties[145]).

7. Click OK.

   The stimulus presentation normally starts by running the calibration.

   The Windows operating system does not distinguish between upper case and lower case letters in file names. For this reason, make sure the entered participant code does not depend on used letter case.
6.4.3.3 Running Calibration

When calibration starts, a center target will appear on the stimulus monitor. If the Show online data option from the Global Settings dialog is activated, the target as well as the participant's gaze position is visible in the preview area displayed in the upper right of the Application Window.

When Validation is selected, the dialog shows the four additional validation points with the average deviation of the participants' gaze to the validation points. The operator can verify the validation quality and decide to continue or repeat the calibration if desired. See the Information on Calibration chapter for the way the quality values are computed.
Select best calibration

The calibration can be repeated multiple times and the results are shown in list.

The operator can select the best calibration from that list and continue with these calibration settings.

Calibration and Validation on demand
Calibration on demand allows to execute a calibration at any point of time during the experiment execution. When the function key F5 is pressed, a temporary calibration element is added in the experiment flow and executed when the currently shown stimulus ends.

Validation on demand allows to execute a validation at any point of time during the experiment execution. When the function key F8 is pressed, a temporary validation element is added in the experiment flow and executed when the currently shown stimulus ends.

For more information about calibration please refer to the iView X Online Help.

### 6.4.3.3.1 Calibration Tips

To execute the calibration successfully please pay attention to the following guidelines.

- The environmental conditions should be approximately the same between calibration and experiment (esp. light level and participant posture).

- RED: Place the participant in a comfortable position in front of and centered to the stimulus monitor. The participant's chair should not have wheels and pivots to minimize the amount of upper body movements made by the participant. A correct distance of the participant to eye tracking device shall be between 60 and 80 cm.

- Advise the participant to minimize his/her head movements. The participant should look at the target while keeping his/her head still as much as possible.

- You should pay attention to the overall screen stimulus brightness and luminosity. If you present very different stimuli in sequence, the participant's pupil will adapt to the light emitted by the screen. For this reason, the same background color should be used throughout all presented stimuli.
6.4.3.4 Running Web Stimuli

When running a web stimulus, screenshots of the webpage contents are taken at various points of page loading in order to ensure the best screenshot possible.

Screenshots can be triggered manually by pressing the Print Screen key, or Pr t Scn on some keyboards. In the case of two keyboard setups the screenshot can be triggered only from the supervisor keyboard.

A icon flashes in the lower right corner of the web stimulus preview whenever a page screenshot is taken, automatically or on user request.

6.4.3.5 Running External Scene Cameras

Running the External Scene Camera stimulus requires a calibration as a first step. Please see the External Scene Camera Calibration appendix on how to do it.
6.4.3.6 Stimuli Presentation

After a successful calibration the system processes the experiment by presenting the stimuli. The transition between stimuli can be executed automatically by the system according to the stimuli properties or manually controlled by the operator.

The following tables give an overview of how to control the stimuli presentation and which keyboard shortcuts are active while presenting the respective stimulus. The **Duration** property of each stimulus determines how the transition between stimuli is triggered.

### Duration property set to “manual”:

<table>
<thead>
<tr>
<th></th>
<th>Text</th>
<th>Question</th>
<th>Image</th>
<th>Web</th>
<th>Movie</th>
<th>Screen Recording</th>
<th>External Video</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic ends if:</strong></td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>End of movie</td>
<td>–</td>
</tr>
<tr>
<td><strong>Next stimulus is presented by:</strong></td>
<td>[ F11] or [ SPACE] or [ &gt;] key</td>
<td>[ F11] or [ SPACE] or [ &gt;] key or [ Cont i n ue] button</td>
<td>[ F11] or [ SPACE] or [ &gt;] key</td>
<td>[ F11] or [ SPACE] or [ &gt;] key</td>
<td>[ F11] or [ SPACE] or [ &gt;] key</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Previous stimulus is presented by:</strong></td>
<td>[ &lt;] key</td>
<td>[ &lt;] key</td>
<td>[ &lt;] key</td>
<td>–</td>
<td>[ &lt;] key</td>
<td>–</td>
<td>[ &lt;] key</td>
</tr>
</tbody>
</table>

### Duration property set to a value in milliseconds:
<table>
<thead>
<tr>
<th></th>
<th>Text</th>
<th>Question</th>
<th>Image</th>
<th>Web</th>
<th>Movie</th>
<th>Screen Recording</th>
<th>External Video</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic ends if:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timed end</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Next stimulus is presented by:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[F11] or [SPACE] or [&gt;] key</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Previous stimulus is presented by:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[&lt;] key</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The operator can stop the experiment at any time by pressing [F12]

or by clicking the

button.

At any time the operator can force a "calibration on demand" by pressing F5 or a "validation on demand" by pressing F8. The calibration/validation will be executed when the current shown stimuli ends and before the next stimulus is shown.

Annotations can be created at any time from the operator when a second keyboard is being used.
6.4.3.7 Create Annotations

Please see the Annotations section.

6.4.3.8 Ending Recording

The recording stops automatically after all stimuli have been presented to the participant. Alternatively, click the button or press the [ F12] key to stop at any time.

Note that all data for the actual participant are always saved into the respective *.idf file, even if you stopped the recording using the [ F12] key.

All files belonging to an experiment will be saved automatically in the experiment folder to the \results subdirectory. The trial separations are created automatically in the respective *.idf file.

When the experiment is finished, you can optionally start BeGaze to analyze the experiment data or export the experiment data via the button.
6.4.3.9 Participant Protocol

A participant protocol is created automatically for each experiment run. The protocol for each participant is stored as CSV compatible text file in the results folder (*.txt). Each protocol text file contains lines with the following data fields:

- the experiment’s name.
- the participant code entered in the participant information dialog.
- the time stamp for the stimulus or event (Hour, Minute, Second, Millisecond from start of trial).
- the stimulus type such as “Text”, “Screen Recording”, “Web”, or the event type such as “Loaded” for finishing to load a web page while running the web stimulus. Especially, the web page URL protocol may be used for web click analysis or for web landing page analysis (see Web Stimulus Element).
- the stimulus or event content such as file names for images, movies and text stimuli, the web page address for the web stimulus / load event, or the executable name and parameters for the screen recording stimulus.

BeGaze extracts the last calibration/validation deviation values from the logfiles and shows them in the subjects statistics template of BeGaze.
6.4.4 Analyzing Experiment Data

For analysis purposes you can view the recorded measurement data in BeGaze. The experiment’s results are stored in *.idf files which are located in the ..\results subdirectory. You can load one of these files in the BeGaze application for visualization and further analysis.

1. Run and end the experiment (see Running an Experiment and Participant Protocol).

2. To further analyze the experiment, click the button in the lower right corner in order to start BeGaze and to automatically load the current experiment data into BeGaze. If the experiment already exists in BeGaze, the existing experiment is being updated with the new data sets. The BeGaze button is enabled if valid data exist and if BeGaze is not already running.

For more information about experiment analysis refer to the BeGaze Online Help.
Chapter VII

Data Storage
7   Data Storage

7.1   Data Storage Structure

Data Collection

A data collection consists of one or several measurement data files, a number of stimulus images and some additional information you have to provide. We call this collection an "experiment". In an Experiment Center experiment, the assembled measurement data files are called "trials".

Experiment Structure

In a typical gaze tracking experiment, the stimulus changes over time. In order to synchronize the measurement data with changes in stimulus presentation, the data files contain either a "set number" or a "user message" at the onset time of the stimulus change. This synchronizing information can be used to separate each trial into "sets", where each set is associated with a certain stimulus image.
7.1.1 Directory Structure

All accumulating data in a gaze tracking experiment will be saved automatically by Experiment Center. They are saved in two different directories created under the configured data path (see Global Settings).

For each experiment, Experiment Center creates two subdirectories to store experiment data:

- Experiments: this directory contains the experiment file (*.EXP) as well as used media such as *.RTF, *.BMP, etc. By default, this directory resides under the program installation directory: C:\Program Files\SMI\Experiment Suite 360\Experiment Center 2\Experiments\[Experiment Name].

- Results: this directory contains the experiment results files including the eye tracking data files (idf). The IDF files are written by the iView X system which responds to the respective commands Experiment Center sends during runtime. By default, this directory resides under the program installation directory: C:\Program Files\SMI\Experiment Suite 360\Experiment Center 2\Results\[Experiment Name].
7.1.2 Importing and Exporting Experiments

Experiment Center supports the import and export of experiments and results to backup or exchange them.

Export of Experiments
From the File menu, select Export Experiments. Select one or more experiments from the dialog and press "Export". Each experiment export file is stored in the name convention of experiment name followed by the suffix ".zep".

Export of Results
From the File menu, select Export Results. Select one or more experiments from the dialog and press "Export". Each result export file is stored in the name convention of experiment name followed by the suffix ".zrs".

Import of Experiments
From the File menu, select Import Experiments. Select one or more Experiment export files (*.zep) from the file dialog. The experiment export files are unpacked into the experiment main directory as defined in the Global Settings.

If the experiment already exists, the import is skipped. In this case, please save the already existing experiment under a new name ("Save as...") and delete it afterwards ("Delete experiment").

Import of Results
From the File menu, select Import Results. Select one or more Result export files (*.zrs) from the file dialog. The result export files are unpacked into the result main directory as defined in the Global Settings.
Do not rename the experiment in the result folder manually. The folder's name is the name of the experiment - which needs to match the file name of the included *.exp and *.mtd files.

7.2 Experiment Files

All files used to create an experiment are stored in a subdirectory under the current Experiment Path setting (see Global Settings). This subdirectory is created when saving the experiment.

The contents of the experiments subdirectory are:

- An *.exp file including the experiment description, the experiment specific settings, as well as all used stimuli with their properties.
- All source files used as stimuli.

Example:

In the following example, the operator entered "slideshow" at the experiment saving prompt.

```
...\experiments\slideshow\n```

- slideshow.exp
- textfile.rtf
- moviefile.avi
- imagefile.bmp
7.3 Results Files

All files used to execute an experiment are stored in a subdirectory under the current Results Path setting (see Global Settings). This subdirectory is created when recording the experiment.

The contents of the results subdirectory are:

- An *.exp file including the experiment description, the experiment specific settings, as well as all used stimuli with their properties.

- Common files among all participants containing the rendered visual stimuli for analyzing the experiment with the BeGaze software. The file names of these files are also used as trial separations in the *.idf file.

- Automatic generated AOI information.

- Several subfolders, one for each recorded participant, named after the participant name and a unique GUID, containing the following:
  - Several *.idf files which contain the measured gaze tracking data – one for each participant. The *.idf file has the following naming convention:
    
    `<participant name>-eye_data.idf`

  - A protocol text file for each participant with the following naming convention:
    
    `<participant name>.txt`

  - Files containing experiment workflow, participant property information, annotations, specific stimuli (like web, screen recording, external video, webcam stimuli), etc.
During a calibration, the idf file recording is interrupted. For this reason, the files stored in the results folder do not include the calibration.

**Rendered stimuli reference**

The presented text and image stimuli are stored as rendered single bitmap files based on screenshots during experiment execution. The naming convention is:

**Text:**  
<generated GUID>_<screen_resolution>.jpg

Image files are stored in a high-quality jpg format using a quality value of 90.

**Image:**  
<generated GUID>_<screen_resolution>.jpg

Web stimuli are stored as a single bitmap of each presented web site (represented by an unique GUID). The naming convention is:

**Web:**  
<generated GUID>.jpg

Movies will be copied from the experiment’s to the result’s directory. The naming convention is:

**Movie:**  
<generated GUID>.avi

Screen recording stimuli will record a movie written to an avi file. The naming convention is:

**Screen Recording:**  
<participant name>-scrrec.avi

External video, external camera and webcam stimuli will record a movie written to a mkv file. The naming convention is:

**External Video:**  
<participant name>-extvid.mkv

**External Camera:**  
<participant name>-extcam.mkv

**Webcam:**  
<participant name>-webcam.mkv
Example:
In the following example, the operator entered "slideshow " at the experiment saving prompt.

```
\results\slideshow\
```

P01-[0821b4fe-3205-4b26-a61e-09dae9fe1a39]
   Logfile_2014_10_29-
   15_04_31_at.lgf
   P01.txt
   P01.xml
   P01-eye_data.idf
   P01-protocol.txt
   stimulus-log.xml

P02-[aa7c3693-b660-43b1-a7d9-c7db8688854c]
   Logfile_2014_10_29-
   15_04_31_at.lgf
   P02.txt
   P02.xml
   P02_questionnaire.tsv
   P02_questionnaire.xml
   P02-eye_data.idf
   P02-protocol.txt
   stimulus-log.xml

38db010acad1663c889dad8444724720
_1920x1200.jpg
4e320f973644e57fcdd04225a9ab611a.a
vi
a4895bc88e933085f0610c8cadd5629e_
1920x1200.jpg
a4895bc88e933085f0610c8cadd5629e_
1920x1200.xml
Example_Slideshow.exp
7.4 Supported File Formats

Experiment Center supports different file formats. While the Experiment Center files and the gaze tracking data are specific to SMI software, all media components presented as stimuli are generally supported by the underlying Windows operating system and the Windows Media Player. For this reason, it is possible to use third party tools and software to create or change media files which are used as stimulus, provided that the following file formats are supported:

Text Media

All text media are stored as RTF (Rich Text Format). Experiment Center supports a subset of the RTF file format specification, which includes basic font attribution, font size, alignment, and indenting and list formats.

It is possible to import ASCII text with the text editing component. To use a more complex file as stimulus, for example a file created with Microsoft Word, you may filter the file by copying and pasting the contents via the Windows clipboard.

Image Media

For image media, the following file formats are supported:

- **BMP**: an older file format supported on all Windows versions; has different color depth variants, such as black & white, 16 colors, 256 colors, and true color.
- **JPG**: preferred for photographic images; true color model only; saves disk space but may show compression artifacts if repeatedly opened, changed and saved.
- **PNG**: a newer compressed and lossless image format; has a 256 color and a true color variant.
- **WMF, TIF**
For optimal display, the image file should have the same dimensions and color depth as the display resolution used for the participant’s monitor. Although it is possible to scale the image media during presentation, this may produce unwanted raster image scaling artifacts.

All of the above image file formats are supported by common image editing software. If no conversion is available, you can copy the raster image to the Windows clipboard, then paste the image into the Windows Paint accessory. Then you can save it to a disk file from there.

Web Media

A typical web site consists of HTML and embedded media. The desired web site presented as stimulus needs to be displayed correctly in the installed Internet Explorer or Firefox version.

Movie Media

Experiment Center converts (re-encodes) movies automatically to an optimized avi format. SMI is using a customized video codec XMP-4 from xVid Solutions. The following movie files can be selected before re-encoding: avi, wmv, asf, mpg, mpeg, mpe, vob, mp4, m4v, m2v. Please ensure that you've installed a valid codec that allows to playback the original movies on the PC before you load them into Experiment Center.

Screen Recording and External Video Media

All screen video material captured during experiments is saved to the hard disk in the AVI file format. The screen recording of Experiment Center uses the customized xVid Solutions MPEG-4 codec (XMP-4) installed during Experiment Suite 360° setup. The XMP-4 codec is compatible with standard Xvid and DivX codecs for playback.

All screenshots taken during the stimulus presentation are saved to hard disk in the jpg file format (see above).
Appendix

Chapter
8 Appendix

8.1 Limitations / Setup recommendations

The performance requirements vary based on the type of stimuli, complexity of the experiment and the connected iView X eye tracking system.

Therefore not all types of experiments can be executed in a one-PC-setup, where iView X and Experiment Center are running on the same PC. For highest performance and best data quality a dual-PC-setup is recommended.

The following table is showing the dependencies and setup requirements for the available stimuli types.

**One PC Setup** System Setup conditions:

Test condition passed:

- iView X frame drops: < 1%
- with Webcam user recording (verified with sample experiments)

<table>
<thead>
<tr>
<th>System Setup*</th>
<th>One PC Setup (Dual Monitor)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IView X Interface</td>
<td>RED4</td>
</tr>
<tr>
<td>Sampling frequency</td>
<td>50Hz</td>
</tr>
<tr>
<td>IView X Laptop Lenovo T500</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Laptop Lenovo T500</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Laptop Lenovo T500</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Laptop mySN Clevo G63M</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Laptop mySN Clevo G63M</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Cube PC (17)</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Cube PC (17)</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Tower (Core-Duo)</td>
<td>yes</td>
</tr>
<tr>
<td>IView X Tower (17)</td>
<td>yes</td>
</tr>
</tbody>
</table>

*Test Conditions: Passed = iView X frame drops < 1% / with & without Webcam (verified with sample experiments)
SMI guarantees Experiment Center and BeGaze to work within the following limits:

Max. number of stimuli in one experiment 250
Max. number of trials per stimulus 250
Max. length of video / max. number of videos 2h / 5
Max. length of video / max. number of videos 1min / 200
Max. number of participants per experiment 200
Max. length per trial / max. number of stimuli 2h / 5
Max. length per trial / max. number of stimuli 10min / 200
Max. stimulus size (excl. Web) 1680x1050
Max. stimulus size for Web (Internet Explorer) 1680x10.000
Max. stimulus size for Web (Firefox) 1680x20.000
Max. experiment size 4GB
Max. screen recording resolution 1680x1050
Max. resolution for external video 1080p

Screen recording performance depends on a lot criteria's (e.g. Processor, graphics board, configuration of the Operating system, used driver, performance used by the application under test) and therefore performance figures cannot be guaranteed.

Possible dropouts and strange behaviour may be encountered with videos when using a dual monitor setup on Fujitsu Siemens T8410 laptops, with web, background screen recording and webcam.

Movies can be used up to 1080p/60fps.
8.2 Dongle Installation and Troubleshooting

Experiment Center is dongle-protected. You may have to place the USB-dongle in the appropriate PC before you can start the program. If Experiment Center displays a message box stating **HASP SRM Protection System: The software requires a hardware key (dongle)**, check the following:

1. The activity LED of the USB-dongle should show a red light if the dongle is plugged in.

2. If the activity LED does not show a red light, check the USB port status in the Windows hardware settings dialog. Open the Windows **Control Panel** and double click the **System** icon. Click on **Device Manager** in the left bar (Windows 7) or switch to the **Hardware** tab and click on the **Device Manager** button (Windows XP). Verify, that the **Universal Serial Bus controllers** tree does not show any yellow warning signs (!). The screenshot below shows a functional USB port with a correct Windows driver installation.

   ![USB port screenshot]

   If the dialog displays a warning sign (!) for a driver, right click the entry and select the **Update Driver...** command from the context menu.

3. Verify, that the dongle driver is installed properly. Open the Windows **Control Panel** and double click the **Programs and Features** icon (Windows 7) or the **Add or Remove Programs** icon (Windows XP). Check if the list shows the **Sentinel Runtime** from SafeNet Inc entry.
Note, that the **Sentinel Runtime** is installed during the installation of Experiment Center. Do not deny the installation of this software during installation when prompted.

Type and status of your licenses are stored on the dongle device, not on the PC on which Experiment Center is installed. With the license update procedure, the dongle is updated. That means, that you can run Experiment Center on any PC when the dongle is plugged in.

### 8.3 External Video Setup

Connecting an external video source is possible by using an external Magewell USB Capture or Epiphan AV.io or DVI2USB 3.0 frame grabber devices.

The SMI **external video package** contains:

- Installation CD containing Installation Guide and User Guide
- Magewell USB Capture or Epiphan AV.io or Epiphan DVI2USB 3.0 (DVI/HDMI to USB 3.0 frame grabbers)

The previous SMI *external video package* contained:
- Installation CD containing VGAPCIe Driver, Installation Guide and User Guide
- VGA2PCIe from Epiphan (VGA to PCI Express frame grabber)
- HDFury 2 from HDFury (HDMI to VGA deciphering converter)
- Audio cable
- HDMI cable

### 8.3.1 External Video Hardware Setup

**External Frame Grabber**

There are two ways the video source can be connected to the frame grabber:

The video source can be connected to the grabber via **HDMI or DVI** and then the grabber is connected to a USB 3.0 port in the PC with a USB 3.0 cable.
The video source can be connected to the grabber via VGA and then the grabber is connected to a USB 3.0 port in the PC with a USB 3.0 cable.

Connect the video source to the frame grabber as follows.

- **Connection via HDMI:**

  **Option 1**
  - Use the Magewell USB Capture grabber, which offers direct HDMI connection from the external video source (Playstation, etc.) and USB 3.0 connection to the PC that carries both the video and audio streams.

  ![USB Capture HDMI](image)

  **Option 2**
  - Connect the video source (e.g. Playstation) with a HDMI cable to the DVI port of the Epiphan grabber using a normal HDMI to DVI adapter.
- The audio is passed through the HDMI cable and the HDMI to DVI adapter and then through the grabber's USB cable together with the video so there is no need for extra cables. Connecting the Playstation to the grabber using only the HDMI to DVI adapter works only if HDCP is disabled on the Playstation. On Playstation 4, go to Settings > System section and turn off Enable HDCP.

**Option 3**

- If HDCP can't be disabled or the game won't run properly with it disabled then a different setup is needed to connect the HDMI cable from the Playstation to the DVI input of the grabber: it needs an HDMI splitter placed between them, which will take care of the HDCP encryption, as shown in the example below.

- One of the splitter HDMI outputs will be connected to the grabber either directly with an HDMI to DVI cable or an HDMI cable and a regular HDMI to DVI adapter as above. The audio cable will be connected between the HDMI splitter audio output and the Experiment Center PC, just like in the "connection via VGA" case above.
Connection via VGA:

- Connect the video source (e.g. PC, MAC) with a VGA cable to the DVI port of the grabber using a normal VGA to DVI adaptor.

- Connect the audio cable from the loudspeaker/line-out port of the video source to the line-in port of the Experiment Center PC. If your Experiment Center PC doesn't contain a line-in port, please use the microphone port.

  Note that the line-in port is usually marked in blue on the PC and the microphone port is usually marked in pink.

  Some laptops have a combo headphone and microphone input, the way it is usually found on smart phones. If this is the case for your Experiment Center PC then in order to input sound via the microphone line an adapter is necessary.

Internal Frame Grabber

There are two ways the video source can be connected to the VGA2PCle frame grabber:
The video source can be connected to the internal PCIe card in the computer via **VGA**.

The video source can be connected to the internal PCIe card in the computer via **HDMI**.

⚠️ If you switch from one external video source to another you might need to change settings slightly.

**HDFury 2** is a HDCP deciphering converter that need to be used to decipher the video signal from game consoles.

---

1. Do not connect to power yet, except for the Experiment Center PC.
2. Connect the video source to the VGA2PCIe frame grabber as follows.

<table>
<thead>
<tr>
<th>Connection via <strong>VGA</strong>:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Connect the video source (e.g. PC, MAC) with a VGA cable to the VGA port of the grabber card.</td>
</tr>
</tbody>
</table>
- Connect the video source (e.g. Playstation) with a HDMI cable to HDFury 2.

Please ensure the little switch of HD Fury 2 is set to "RGB"! If the switch is set to "YUV", your screen will turn green.

- Connect HDFury 2 to the VGA port of the grabber card.

3. Connect the audio cable to the Experiment Center PC.

- Connect the audio cable from the loudspeaker/line-out port of the video source to the line-in port of the Experiment Center PC. If your Experiment Center PC doesn't contain a line-in port, please use the microphone port.

  Note that the line-in port is usually marked in blue on the PC and the microphone port is usually marked in pink.

- Connect the audio cable from HD Fury 2 to the line-in port of the Experiment Center PC. If your Experiment Center PC doesn't contain a line-in port, please use the microphone port.
Note that the line in port is usually marked in blue on the PC and the microphone port is usually marked in pink.

8.3.2 Software Installation

**External Frame Grabber**

1. Check if you are logged in as administrator by clicking Start → Control Panel → User Accounts → Administrator.

2. Install needed software.

   - For the Magewell USB or Epiphan AV.io frame grabbers: no software is needed for receiving the video and audio streams on the PC, it acts as a standard webcam. For tools and firmware updated there is the manufacturer's website: http://www.magewell.com/usb-capture-hdmi/tool (Magewell) or https://www.epiphan.com/products/avio-hd/avio-hd-downloads (Epiphan).

   - For the Epiphan DVI2USB 3.0 frame grabber: download and install the latest drivers from the manufacturer's website: http://www.epiphan.com/products/frame-grabbers/dvi2usb-3-0/download/
In case the frame grabber doesn't work well or at all:

- Make sure the USB 3.0 controller is **enabled** in the BIOS of the PC.
- Make sure the USB 3.0 drivers are installed, as you can check in device manager

**Internal Frame Grabber**

1. Check if you are logged in as administrator by clicking **Start** ➔ **Control Panel** ➔ **User Accounts** ➔ **Administrator**.

2. Install the VGA2PCIe Driver from your Experiment Suite 360° installation CD by clicking **VGA2PCIe Driver** ➔ **Install from CD**. Or you can download the latest drivers from the manufacturer's website: [http://www.epiphan.com/products/frame-grabbers/dvi2pcie/download/](http://www.epiphan.com/products/frame-grabbers/dvi2pcie/download/)

### 8.3.3 Software Configuration

**External Frame Grabber**

No configuration is needed for the Magewell USB Capture or the Epiphan AV.io and DVI2USB 3.0 frame grabber device.

**Internal Frame Grabber**

1. Run the application VGA2PCIe GUI: **Start** ➔ **Programs** ➔ **Epiphan Capture Tool**.

   This is a tool that
   - locates the capture device and
   - configures the device.
2. Set display settings for VGA-Setup (Note: this step is only for VGA-Setup!).

   - On the monitor of your video source PC (virtual monitor), please open the Display Properties and select the Settings tab. As you can see, the Experiment Center PC appears as second monitor.

   - Please check if the screen refresh rate corresponds to the recommended value of 60 Hz by clicking Display Properties ➔ Settings ➔ Advanced ➔ Monitor tab ➔ screen refresh rate.
- For best performance, set the virtual monitor into clone mode.

For further information on how to select the clone mode please refer to your graphic card settings.

3. Set the resolution of your video source according to the recommended settings below:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Device</th>
<th>Mode</th>
<th>Resolution (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI</td>
<td>Game console</td>
<td>Games</td>
<td>lots of interaction, lots of content changes (e.g. racing) recommended 720p max. 1080p (1920x1080)</td>
</tr>
<tr>
<td>VGA</td>
<td>PC</td>
<td>Games</td>
<td>lots of interaction, lots of content changes (e.g. racing) max. 1680x1050</td>
</tr>
<tr>
<td>VGA</td>
<td>PC</td>
<td>Games</td>
<td>medium interaction, medium content changes (e.g. strategic games) max. 1680x1050</td>
</tr>
<tr>
<td>VGA</td>
<td>PC, MAC</td>
<td>Applications</td>
<td>normal user interaction with applications max. 1680x1050</td>
</tr>
</tbody>
</table>

Information: higher resolutions result in lower frames per second - on the screen and in the resulting video recording.
4. If the video source needs to be adjusted to the screen, switch to the **Adjustments** tab and configure the settings.

Please adjust the settings manually until you obtain the optimal image. Most of the time you will want to adjust the **Horizontal shift** and **Vertical shift** to remove any black bands around the video source. These settings simply shift the whole image so it matches the screen edges.

The **PLL adjustment** setting also helps with cases where the image width is larger than the screen width and adjusting this setting allows scaling the width back to the screen. **PLL adjustment** may be needed more for higher resolutions (like 1080p) and must be used together with **Horizontal shift** to achieve a proper horizontal scaling and positioning.

Brightness and contrast should also be adjusted if the source video looks washed out or too bright or too dark. **Use the Set offset/gain** settings for this purpose. The offset and gain settings control the image
brightness and contrast respectively. Increasing the offset control causes the image to become darker. Increasing the Gain control gives the image more contrast.

For any further information please see the additional Epiphan Frame Grabber User Guide (page 136) on your installation CD (Advanced Topics) or on the producer's website (http://www.epiphan.com/pdf/DVI2PCIeUserGuide.pdf).

5. Close the applications.

**Configuring the output display settings of your External Video Source**

The frame grabber package provides for game and TV analysis using external video sources. To ensure that you have the best possible output it is important to verify the display output settings of your external video source.

Although external video sources should automatically choose the best default settings for your combination of display and cables, there are often options on the device to improve the output quality of your display. The options available frequently change depending on which audio-visual (A/V) cable, display, and external video source you use. The frame grabber package has been tested to work with external video sources utilizing display outputs of 480p, 720p, or 1080p. For best results it is suggested that you use the highest output resolution setting of your external video source (1080p > 720p > 480p) and you do not use external video sources at settings other than those specified above.

To configure the output display settings of your particular external video source it is highly recommended that you consult the external video source's manufacturer website.

Listed below are the steps required for configuring the output display settings of two common external video sources, Xbox 360™ and PlayStation® 3 video game consoles.
### Xbox 360™

<table>
<thead>
<tr>
<th>Step #</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On your console, go to My Xbox, and then select System Settings</td>
</tr>
<tr>
<td>2</td>
<td>Select Console Settings.</td>
</tr>
<tr>
<td>3</td>
<td>Select Display.</td>
</tr>
<tr>
<td>4</td>
<td>Select HDTV Settings.</td>
</tr>
<tr>
<td>5</td>
<td>Select the maximum resolution that is supported for your display.</td>
</tr>
<tr>
<td>6</td>
<td>Check your settings. Confirm that the image displayed is at the correct resolution for the display.</td>
</tr>
<tr>
<td>7</td>
<td>Select Yes to confirm the change.</td>
</tr>
</tbody>
</table>

**Optimal Resolution** is the default option when an HDMI cable is used. This option allows the display and Xbox 360™ console to determine the best setting.

### PlayStation® 3 (PS3™)

<table>
<thead>
<tr>
<th>Step #</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On your console, select Settings</td>
</tr>
<tr>
<td>2</td>
<td>Select Display Settings</td>
</tr>
</tbody>
</table>
3 Select Video Output Settings

4 Select the Connector Type of your display. Resolution (video mode) varies depending on the type of connector used.

5 Select all resolutions supported by the display in use. Video will automatically be output at the highest resolution possible for the content you are playing from among the selected resolutions. The video resolution is selected in order of priority as follows: 1080p > 1080i > 720p > 480p > Standard (NTSC:480i/PAL:576i).

⚠️ As previously mentioned, 1080i is not a supported resolution of the frame grabber package.

6 Check your settings. Confirm that the image displayed is at the correct resolution for the display.

7 Save your settings. The video output settings are saved on the PS3™ system.

ℹ️ The cable required to output a particular video mode may not be included with the external video source and additional purchases may be necessary. For details, refer to the documentation supplied with your external video source.

ℹ️ If the video output settings do not match those required for the display in use, the screen may go blank when the resolution is changed. The screen should automatically go back to its original resolution within 30 seconds. If the screen remains blank, you will have to turn off your external video source. The video output settings should automatically be reset to the standard resolution.
8.3.4 Sound Setup

1. Check audio devices by clicking Start → Control Panel → Sounds and Audio Devices.

2. In the dialog click on the Audio tab. Verify the default devices and change them if needed.
3. By clicking Volume... of Sound playback, the following dialog appears:

4. Configure the sound device as follows.

   - Sound source connected via Line-in port:
- Select **Options** → **Properties** and pick the device **Line Volume**.

- Click **OK** and uncheck the **Mute** checkbox for the **Line volume** to hear sound from the external video source.

- **Sound source connected via Microphone port:**
- Select Options ➔ Properties and pick the device Mic Volume.

- Click OK and uncheck the Mute checkbox for the Mic volume to hear sound from the external video source.
- Make sure all Microphone Boosts are disabled as in the following dialog. These can be found under Sound Recording and/or Sound Playback → Mic Volume → Advanced.

5. Now, configure the Sound Recording by clicking Volume....
• When devices can be muted uncheck Mute of all Volume devices except Stereo Mix. Stereo Mix must be muted in both settings.

![Recording Control](image)

• When devices can be selected, then check Select of the used device, e.g.: Mic Volume for microphone port.

![Recording Control](image)

⚠️ Please consider you might have to adjust the sound volume of the input and output manually!

### 8.3.5 Ready to Use

The system is now ready to use the external video package.

You can now insert External Video Source Element.
8.4 External Camera Setup

With the External Camera setup option for the RED line of eye tracking systems, you can analyze visual interaction with a real-world stimulus using an external scene camera to capture its image. This setup requires the “External Camera Package” – a software extension package for Experiment Suite 360°.

8.4.1 System Setup

Setup Overview

Participant

Schematic setup to study human-to-human interaction

Stimulus is on a vertical plain and fits into the viewing angle of the scene camera.
Scene camera is optimally placed on a horizontal line with the stimulus to minimize parallax and distortion.

The External Camera setup option for the SMI RED devices is recommended for eye tracking studies involving real-world stimuli, e.g. in:

- Human-to-human interaction
- Human-machine interaction
- Control rooms with several monitors
- A selected supermarket shelf
- more...

Choose a target area (your stimulus) that fits into the viewing angle of the scene camera. Your stimulus should be on a vertical plain. It is not recommended to use the External Camera setup to analyze an extended 3D space.

**Required hardware and setup steps**

- RED line of eye tracking systems (RED, RED250, RED500)
- RED interface power supply
- Foot for RED stand-alone setup or other fixation for RED device
- External camera (e.g. web cam or DV camcorder)
- Optional: power cord for external camera (if not USB powered)
- USB cable for RED
- USB cable to connect external camera
- Laptop or Cube PC to run SMI iView X™ and SMI Experiment Center™ 3.7 software
- Optional: power cord for PC or laptop
USB dongle for Experiment Suite 360° with additional license for Video Analysis Package and External Camera Package

Print out of calibration scheme to place on stimulus area

**Assembly instructions**

- The External Camera setup option uses the RED stand-alone set up mode.
- Remove your RED from the monitor. Use the stand-alone foot delivered with the device or fixate the RED in an appropriate way.
- Connect the external power supply with the RED interface.
- Use the USB cable to connect the RED with the eye tracking laptop/PC.
- Use the USB cable to connect the external scene camera to the laptop/eye tracking PC.
- If applicable, connect the PC/laptop and the external scene camera with an external power supply.
- Connect the Experiment Suite 360° dongle to the eye tracking laptop/PC.

**System Setup**

- Place the RED in the horizontal middle of the stimulus area at a distance of 60-80 cm in the line of sight of the participant. The bottom of the stimulus should be parallel to the RED. Make sure the upper border of the device will just allow the participant to look at the stimulus area.
- Adjust the inclination angle of the device. Make sure that the eyes of the participant are in the center of the RED tracking monitor.
- Place the external scene camera (e.g. camcorder or a web cam) on a horizontal line with the stimulus area close to the head of the participant. Optional: For easy adjustment, mount the external scene camera on a customized, flexible arm (not included). Adjust the position
so that the camera captures the whole target area. If necessary, adjust the zoom of the external scene camera.

8.4.2 External Scene Camera Calibration

Print out the pdf file with the calibration scheme you intend to use (2, 5 or 9 points) scaled to the size of your natural stimulus, e.g. the size of a human face. You can download the pdf files with the calibration schemes from this address: http://www.smivision.com/index.php?id=434.

In case you use a custom calibration sheet, make sure that organization of calibration points follows the pattern described below. SMI recommends to use a 5 points calibration scheme as the default mode.

![Correct 2-point calibration scheme](image1)

![Wrong 2-point calibration scheme](image2)

2-points: Calibration points MUST BE placed on a diagonal axis from the top left corner to the bottom right corner of the stimulus area.
5-points: Calibration points MUST NOT be placed on the same horizontal or vertical line.

9-points: Calibration points MUST BE placed on the same horizontal and vertical line of a rectangular.
Performing a Calibration

- Place the paper with the calibration scheme on the stimulus area in the field of view of the external scene camera, with all corners visible.
- Resize the yellow rectangle to match the calibration paper size as close as possible!
- Move the calibration points to match the points drawn on the calibration paper.
- Set calibration setting “accept points automatically” to “no”.
- Lock the experiment and press “Record”.
- While calibrating, tell the participant which calibration point he should look at on the sheet of paper, according to the calibration point presented in the camera preview.
- Accept each point by pressing the space bar.

Data Recording

- After the calibration ends, the actual video recording begins. Remove the sheet of paper from the camera scene and start your experiment.
• Please note: The camera initialization might take a few seconds until the data and video recording starts after a calibration.

Analysis

• After you have finished recording with all participants, click on the SMI BeGaze™ icon in SMI Experiment Center™ 3.7.

• Use SMI BeGaze™ to analyze statistical data and create visualizations.
8.5 Information on Calibration

Calibration is the process where the iView X system establishes the relationship between the position of the eye in the camera view and a gaze point in space, the so-called point of regard (POR). The calibration also establishes the plane in space where eye movements are rendered. Since this relationship strongly depends on the overall system setup and also varies between participants, a reference measurement called calibration must be performed before each experimental trial.

The Validation is ran afterward to check the quality of the calibration by following a similar procedure as the calibration one and computing the deviation of the gaze from the validation target points.

During calibration and validation, the participant is presented with a number of targets in known locations. These targets must be fixated by the participant and the position of the eye is noted by the system. Using these reference points, the system creates a mapping function that relates all eye positions to points in the calibration area (monitor).

The accuracy of gaze data is directly related to the success of the calibration.

Calibration and Validation deviation calculation

1. A validation Point \( v_p \) is shown on screen. The procedure continues with the next point after detecting a stable fixation.

2. The mean position \( g \) of the gaze data that was recorded during the fixation period is calculated.

3. The distance \( d_{px} = g - v_p \) between mean gaze position and validation point is calculated.

4. The angular deviation \( \varepsilon = \tan^{-1} \frac{d_{px} + ps}{hs} \) using the distance between head and stimulus \( hs \) and the pixel size \( ps \) is calculated.

5. All calculations are done for x and y separately.
6. Experiment Center calculates the average angular deviation for all validation points.

For more information on calibration, please refer to the iView X Online Help.

An average distance of 700 mm is used for RED devices for angular deviation calculation.

8.6 Information on User camera and Audio Recording

The observation package license is needed to record user video and user audio.

SMI delivers a selected and verified Webcam with the observation package to ensure best results (video resolution, dropped frames, delay).

The recording of a video and audio can be switched on and off in the Global Settings dialog.

There are two modes available:

- Video recording only
- Video recording and audio recording
8.7 Program Installation

The product installation media (CD-Rom) offers suitable software packages to install. Please run the auto-start application from the installation medium and click on the respective buttons to install necessary software.

The Experiment Suite 360° includes the Experiment Center as well as the BeGaze software. To install the Experiment Suite 360°, proceed as follows:

1. Insert the installation media (CD-Rom).
   The auto-start application opens.

2. Click on the **Install from CD** button.
   Follow the steps of the installation wizard.
While installing the Experiment Suite 360°, the USB dongle driver (Sentinel Runtime) is installed or updated. You may need to update the USB dongle license information. Refer to the BeGaze manual under "Dongle Protection and License Update" for details.

The Microsoft .NET Framework, Microsoft Internet Explorer, and Microsoft Media Player software components are available from the Experiment Center installation media. These software components are also available from the Microsoft web site where you can download them for installation to the desired PC workstation. Both software components will inspect your PC workstation during installation and may issue warning messages if the PC resources do not meet the necessary performance.

Please use always the latest versions that are available for download from the Microsoft web site.

8.8 System Requirements

You can install and run Experiment Center on a standard PC workstation running the Microsoft Windows operating system if the following requirements are met:

- Experiment Center is based on the Microsoft .NET Framework Version 4.0 or above. This in turn requires Microsoft Windows Vista, Microsoft Windows 7, 8, 8.1 or 10 operating systems.

Experiment Center is not compatible with Windows Vista Home Premium.
The PC and Windows OS must be compatible with European or American keyboard and language settings. Asian language settings (e.g. Chinese) are not supported.

The PC workstation performance should be sufficient to display or play the different media types presented during Experiment Center execution. To do so, you need adequate CPU performance combined with enough RAM and hard disk space as well as a 3D accelerated graphics adapter. This should be true for any notebook or desktop computer bought since 2007. At minimum, you need a 2 GHz Core-Duo Processor, 2 Gb of RAM and at least 10 Gb of free hard disk space. You also need a monitor together with a true color display adapter with a minimum resolution of 1280x1024 pixels to do meaningful experiments.

You also need the Microsoft Media Player 11 or above and the Microsoft DirectX 9 multimedia runtime or above installed. You may verify the media performance by test playing a DVD film or something similar.

If you run Experiment Center on the same PC workstation as the iView X gaze tracking system, keep in mind that during an experiment the CPU will need spare resources to examine and calculate the incoming gaze tracking data. In case you want to do experiments with different monitors for participant and operator, you also need a display adapter capable of driving a secondary display such as a notebook computer with an additional display jack.

If you run Experiment Center on a separate PC workstation, you need at least a 100 Mbit Ethernet interface adapter to connect with the PC workstation running the iView X gaze tracking system.

For Web analysis, the latest approved version of Mozilla Firefox and Microsoft Internet Explorer should be used. These can be found in the About Experiment Center dialog.

In order to run Experiment Center, administrator privileges are required.
All video content created by Experiment Center, such as observation package content, external video, screen recordings, etc., is created as MKV files (Matroska container format), video is encoded with the XMP4 encoder, which is installed at the same time as Experiment Center and is an Xvid compatible encoder using the H.263 standard, and audio is uncompressed PCM data.

Note that iView X version 2.4.33 or higher is required to run Experiment Center. If you try to connect to an incompatible version of iView X, Experiment Center displays a corresponding message box and terminates. You need to update your iView X software in this case.

Compliant and non-compliant graphic cards for Experiment Center and BeGaze

The following list contains the tested graphic card models that are compliant (recommended = yes) and non compliant (recommended=no) with Experiment Center and BeGaze.

(This list is not intended to be complete)

<table>
<thead>
<tr>
<th>Recommended</th>
<th>Vendor</th>
<th>Model</th>
<th>Memory (MB)</th>
<th>Shared Memory</th>
<th>OpenGL Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>yes</td>
<td>Intel</td>
<td>GMA 3100</td>
<td>384</td>
<td>Yes</td>
<td>1.4</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 7600 GS</td>
<td>256</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 8500 GT</td>
<td>512</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9600 GT</td>
<td>512</td>
<td>No</td>
<td>3.0</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 6200</td>
<td>128</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 8800 GTS</td>
<td>320</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>yes</td>
<td>ATI</td>
<td>Radeon X1050</td>
<td>256</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 8600 GT</td>
<td>256</td>
<td>No</td>
<td>3.2</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9500 GT</td>
<td>512</td>
<td>No</td>
<td>3.0</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9400</td>
<td>512</td>
<td>No</td>
<td>3.2</td>
</tr>
<tr>
<td>yes</td>
<td>ATI</td>
<td>Mobility Radeon 9000 IGP</td>
<td>128</td>
<td>Yes</td>
<td>1.3</td>
</tr>
<tr>
<td></td>
<td>GPU Manufacturer</td>
<td>GPU Model</td>
<td>Memory (MB)</td>
<td>supported</td>
<td>API version</td>
</tr>
<tr>
<td>---</td>
<td>------------------</td>
<td>-----------</td>
<td>-------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX440</td>
<td>512</td>
<td>No</td>
<td>4.0</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX460</td>
<td>768</td>
<td>No</td>
<td>4.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX580</td>
<td>1536</td>
<td>No</td>
<td>4.1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GT440</td>
<td>1024</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX460GS</td>
<td>1024</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX570</td>
<td>1280</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce GTX660</td>
<td>2048</td>
<td>No</td>
<td>4.3</td>
</tr>
<tr>
<td>yes</td>
<td>ATI</td>
<td>Mobility Radeon HD 4570</td>
<td>512</td>
<td>No</td>
<td>3.0</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>NVS 4200M</td>
<td>1024</td>
<td>Yes</td>
<td>4.1</td>
</tr>
<tr>
<td>yes</td>
<td>Intel</td>
<td>Intel HD Graphics Family (i3/i5/i7 integrated)</td>
<td>1556</td>
<td>Yes</td>
<td>3.0</td>
</tr>
<tr>
<td>no</td>
<td>Matrox</td>
<td>Orion</td>
<td>32</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>Matrox</td>
<td>G550 DH</td>
<td>32</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 5200 FX</td>
<td>128</td>
<td>No</td>
<td>2.1</td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>FireGL V 3400</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 8400</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX1700</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX570</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX5500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>FireGL V 3100</td>
<td>128 MB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>Radeon HD4350</td>
<td>512</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>Radeon HD5450</td>
<td>512</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>Radeon HD5770</td>
<td>1024</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>Radeon HD5830</td>
<td>1024</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 210</td>
<td>512</td>
<td>4.0</td>
<td></td>
</tr>
</tbody>
</table>
8.9 Troubleshooting

This chapter explains some warnings and error messages that might occur and describes what the user should do in these cases.

Video Playback

If you experience problems during video playback, examine the Media Player's Help: Troubleshooting menu command as well as the Media Player's Tools: Options: Performance dialog tab. You may also run the DirectX diagnosis tool to verify the PC's capabilities. From the Windows Start menu, select the Run command, type in "dxdiag", then confirm with OK.

System Performance

Certain background processes and services require substantial system resources during execution. While this does not affect the system during idle times, those background processes may disturb a running gaze tracking experiment. If you notice a degradation in system responsiveness, you may consider the following points:

- Disable the background scan function of your virus scanner. This function scans newly started executables and various file formats while they are read in from the hard disk drive. Use the on-demand virus scan function instead.

- Make sure that no CPU consuming screen saver is automatically activated during a running experiment. It is best to completely switch off the screen saver during an experiment.

- You may also deactivate any auto-update functions. While background downloading of files does not normally use too much system resources, confirmation dialogs and update notices may disturb an experiment.
Also check the power configuration of a notebook PC. In the Windows Control Panel, select the Performance and Maintenance category. Start the Power Options applet and select the “Presentation” entry in the Power Schemes list.

Please verify that your system setup as well as the experiment setup is matching our recommendations (see also: System Requirements).

Experiment Center does not start

It is not sufficient, to simply copy the Experiment Center program directory to another PC. Please use the Experiment Center installer. This ensures for example that required Microsoft .NET Framework Version 4.0 or above is installed properly. Note that you cannot start Experiment Center from a network share / network drive because of .NET security restrictions.

Internet Explorer plugin wasn't detected

When starting a web stimulus, if you receive an error message saying that the communication with the Internet Explorer Browser couldn't be established, then please open Internet Explorer from your Windows start menu, navigate to Tools->Manage Addons and look for an entry named ExperimentCenter.Web.ExperimentCenterIEAddOn. If it exists and it's status is disabled, please enable it. If the entry doesn't exist at all, reinstalling Experiment Suite should fix the problem.
View and manage your Internet Explorer add-ons

Add-on Types

- Toolbars and Extensions
- Search Providers
- Accelerators
- InPrivate Filtering

Show:
- Currently loaded add-ons
- Not Available

ExperimentCenter.Web.ExperimentCenterTeAddOn
(Not verified) SensoMotoric Instruments GmbH

Version: 1.0.0.27.0
File date: More information

Type: Browser Helper Object
Search for this add-on via default search provider

Enable
Close

End more toolbars and extensions...
Learn more about toolbars and extensions
8.10 Screen recording of media player windows

It might be that you want to turn do a screen recording of a media player (like Windows Media Player) playing a movie. Usually the video content won't be visible in the screen recording output file because the video surface is drawn using hardware acceleration.

To work around this you need to change the rendering surface of the media player to something that does not use DirectX (including Direct3D). For example in the VLC player go to Tools -> Preferences -> Video and select OpenGL video output from the Output drop down. Similar options should exist in other players.
Another option that is not recommended is to completely disable the hardware acceleration from the Advanced options of Windows Display Properties. This is not a very good solution because it completely turns off the acceleration on the computer making Experiment Center and other software slower.
8.11 Web Stimulus Trial creation when using Mozilla Firefox

When using Mozilla Firefox, a new trial is created when the page is about to start rendering. From this moment on, the browser waits maximum 250 ms to download page contents (dependent on page size) and then renders what was downloaded until that moment.

Page loading events that are also recorded and available in BeGaze are:

- The DOM Content Loaded event, that is fired when the document has been completely loaded and parsed, without waiting for stylesheets, images, and subframes to finish loading. (https://developer.mozilla.org/en-US/docs/Web/Events/DOMContentLoaded)

- The URL Completely Loaded event, that fires at the end of the document loading process. At this point, all of the objects in the document are in the DOM, and all the images, scripts, links and subframes have finished loading. (https://developer.mozilla.org/en-US/docs/Web/API/GlobalEventHandlers.onload)

8.12 Integration with Noldus Observer

The integration is described in a dedicated manual available from Noldus.
Copyright and Trademarks
9 Copyright and Trademarks

Copyright

The SOFTWARE is owned by SensoMotoric Instruments GmbH or its suppliers and is protected by the Federal Republic of Germany copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g. book or musical recording) except that you may either

a) make one copy of the SOFTWARE solely for backup or archival purposes or

b) transfer the software to a single hard disk provided you keep the original solely for backup or archival purposes.

You may not copy the written materials accompanying the SOFTWARE.

The user is not entitled to allow a third party to use the software simultaneously without written approval of SensoMotoric Instruments GmbH. Independent branch offices or subsidiary companies are also understood to be a third party in this sense. SensoMotoric Instruments GmbH and/or its supplying firm remain the owners of the delivered software, even if it is altered.

Trademarks

BeGaze is a trademark of SensoMotoric Instruments GmbH.

iView X is a trademark of SensoMotoric Instruments GmbH.

Experiment Center is a trademark of SensoMotoric Instruments GmbH.

SensoMotoric Instruments is a trademark of SensoMotoric Instruments GmbH.

Microsoft, Windows are registered trademarks of Microsoft Corporation.
License Agreement and Warranty

Chapter
10 License Agreement and Warranty

IMPORTANT – PLEASE READ CAREFULLY: This license agreement (“Agreement”) is an agreement between you (either an individual or a company, “Licensee”) and SensoMotoric Instruments GmbH (“SMI”). The “Licensed Materials” provided to Licensee subject to this Agreement include the software programs, which were installed on the equipment Licensee purchased from SMI (the “Designated Equipment”) at the time of delivery of the Designated Equipment and/or other software programs SMI has granted Licensee access to (the “Software”) as well as any “on-line” or electronic documentation associated with the Software, or any portion thereof (the “Documentation”), as well as any updates or upgrades to the Software and Documentation, if any, or any portion thereof, provided to Licensee at SMI’s sole discretion.

By installing, downloading, copying or otherwise using the Licensed Materials, you agree to abide by the following provisions. This Agreement is displayed for you to read prior to using the Licensed Materials.

The Software is provided with and uses libraries from the FFmpeg project under the LGPLv2.1, GNU Lesser General Public License (LGPL) version 2.1 or later (the “FFmpeg Libraries”), which are not owned by SMI. The FFmpeg code owners’ contact information and the LGPLv2.1 licensing terms and conditions can be found at http://ffmpeg.org

If you do not agree with these provisions, do not download, install or use the Licensed Materials. If you have already paid for the Licensed Materials, you may return them for a full refund to: SensoMotoric Instruments, Warthestraße 21, 14513 Teltow, Germany. If the Licensed Materials were installed on Designated Equipment, you may also return such Designated Equipment for a full refund.

1. License. Subject to the terms of this Agreement, SMI hereby grants and Licensee accepts a non-transferable, non-exclusive, non-
assignable license without the right to sublicense to use the Licensed Materials only (i) for Licensee’s business operations, (ii) on the Designated Equipment, if any, or on a back-up equipment while the Designated Equipment is inoperable, and (iii) in accordance with the Documentation. Licensee may make one copy of the Software in machine readable form for backup purposes only; every notice on the original will be replicated on the copy. Installation of the Software, if any, is Licensee’s sole responsibility.

2. Rights in Licensed Materials. Title to and ownership in the Licensed Materials and all proprietary rights with respect to the Licensed Materials and all copies and portions thereof, remain exclusively with SMI. The Agreement does not constitute a sale of the Licensed Materials or any portion or copy of it. Title to and ownership in Licensee’s application software that makes calls to but does not contain all or any portion of the Software remains with Licensee, but such application software may not be licensed or otherwise transferred to third parties without SMI’s prior written consent.

3. Confidentiality. Licensed Materials are proprietary to SMI and constitute SMI trade secrets. Licensee shall maintain Licensed Materials in confidence and prevent their disclosure using at least the same degree of care it uses for its own trade secrets, but in no event less than a reasonable degree of care. Licensee shall not disclose Licensed Materials or any part thereof to anyone for any purpose, other than to its employees and sub-contractors for the purpose of exercising the rights expressly granted under this Agreement, provided they have in writing agreed to confidentiality obligations at least equivalent to the obligations stated herein.

4. No Reverse Engineering. License shall not, and shall not allow any third party to, decompile, disassemble or otherwise reverse engineer or by any means whatsoever attempt to reconstruct or discover any source code or underlying ideas, algorithms, file formats or programming or interoperability interfaces of the Software or of any files contained or generated using the Software. The obligations under this Section shall survive any termination of the Agreement. Licensee may apply to SMI at the address above for further information on the
interface between the Software and other applications; SMI will on reasonable terms and conditions provide such information as the Licensee may reasonably require to enable the Software to interoperate with its applications. These restrictions do not apply to the FFmpeg Libraries.

5. **Warranty.**
   a) If Licensed Materials show a defect during the limitation period specified in Sec. 5 d), which already existed at the time of transfer of risk, SMI will provide Licensee with a corrected version of such defective Licensed Material (“Repeat Performance”).
   b) Licensed Materials are defective, if they do not conform to the written agreement between SMI and Licensee, if any, or to SMI’s specification.
   c) Licensee’s claims for defects are excluded:
      - for insignificant divergences from the agreement or specification;
      - for damages caused after the transfer of risk by external influences such as fire, water, currency surge, etc.; improper installation, operation, use or maintenance; use in fields of application and environmental conditions other than those expressly specified by SMI; and use in combination with other products not approved by SMI for this purpose, excessive stress or normal wear and tear;
      - for defects of the Software, which cannot be reproduced;
      - for Licensee’s or a third party’s modifications of Licensed Materials and results therefrom;
      - in as far as Licensee has not notified SMI of apparent defects within 5 business days of delivery and of hidden defects within 5 business days of discovery.
   d) The limitation period for warranty claims is 12 months. This does not apply in cases of fraud, intent, gross negligence and personal injury. Repeat performance does not restart the limitation period.
   e) Licensee has to always first provide SMI the opportunity for Repeat Performance within a reasonable period of time. Repeat Performance does not constitute acceptance of a legal obligation.
   f) If the Repeat Performance fails even within an additional period of time of reasonable length to be granted by Licensee, Licensee
shall, notwithstanding its claims under Section 6, if any, be entitled
to rescind the contract or to claim a price reduction.

g) If the analysis of an alleged defect shows that it is not covered by
the above warranty, SMI may charge for the failure analysis and
correction of the defect, if any, at SMI's then applicable rates.

6. **Liability Limitations.**

a) SMI is only liable for damages caused by slight negligence if such
are due to a material breach of duty, which endangers the
achievement of the objective of the Agreement, or the failure to
comply with duties, the very discharge of which is an essential
prerequisite for the proper performance of the Agreement.

b) In cases of Section 6 a), the liability is limited to the damage,
which is typical for contracts like this Agreement and which could
have been foreseen.

c) SMI's liability is also limited to the damage, which is typical for
contracts like this Agreement and which could have been foreseen
for damages caused by the gross negligence of an agent or an
employee of SMI, who is not an officer or executive of SMI.

d) In cases of Sections 6 a) and c), SMI's liability is limited to a
maximum amount of EURO 500.000, respectively EURO 100.000
for financial losses.

e) Licensee’s claims for damages caused by slight negligence or
cased by the gross negligence of an agent or an employee of
SMI, who is not an officer or executive of SMI, which are not based
on defects and thus not subject to time-barring in accordance with
Sec. 5 d) are time-barred at the latest 2 years from the point in
time Licensee became aware of the damage and regardless of
Licensee’s awareness at the latest 3 years after the damaging
event.

f) With the exception of liability under the Product Liability Law, for
defects after having given a guarantee, for fraudulently concealed
defects and for personal injury, the above limitations of liability
shall apply to all claims, irrespective of their legal basis, in
particular to all claims based on breach of contract or tort.

g) The above limitations of liability also apply in case of Licensee’s
claims for damages against SMI's employees or agents.
7. **SMI Indemnity.** SMI will defend or settle any action brought against Licensee to the extent based on a claim that Licensed Materials, used within the scope of the license granted in this Agreement, infringe any copyright valid in the European Union or the European Economic Area and will pay the cost of any final settlement or judgment attributable to such claim, provided (i) Licensee has given prompt notice to SMI of such claim, (ii) Licensee has not recognized an infringement of the third party’s copyright, and (iii) the entire defense and the settlement negotiations are reserved for SMI with Licensee’s full cooperation and support. If Licensee discontinues the use of Licensed Materials for damage reduction or other important reasons, Licensee is obligated to point out to the third party that the discontinuation of use does not constitute an acknowledgement of a copyright infringement. If SMI believes Licensed Materials are likely to be the subject of an infringement claim, it may elect to replace or modify such Software or Documentation to make it non-infringing or terminate the Agreement on written notice to Licensee. SMI shall have no obligation to defend (or any other liability) to the extent any claim involves a Software release other than the current, unaltered release, if such would have avoided infringement, or use of the Software in combination with non-SMI programs or data, unless the infringement would also incur without such combination. The foregoing states the entire obligation and liability of SMI with respect to any infringement by Licensed Materials of any intellectual property rights or other proprietary rights of Licensee or a third party without prejudice to any claims for damages in accordance with Section 6.

8. **Licensee Indemnity.** Licensee will defend and indemnify SMI, and hold it harmless from all costs, including attorney’s fees, arising from any claim that may be made against SMI by any third party as a result of Licensee’s use of Licensed Materials, excluding claims for which SMI is obligated to defend or indemnify Licensee under Section 7.

9. **Export Restriction.** Licensee will not remove or export from Germany or from the country Licensed Materials were originally shipped to by SMI or re-export from anywhere any part of the Licensed Materials or any direct product of the Software except in compliance with all
applicable export laws and regulations, including without limitation, those of the U.S. Department of Commerce.

10. **Non-Waiver; Severability; Non-Assignment.** The delay or failure of either party to exercise any right provided in this Agreement shall not be deemed a waiver. If any provision of this Agreement is held invalid, all others shall remain in force. Licensee may not, in whole or in part, assign or otherwise transfer this Agreement or any of its rights or obligations hereunder.

11. **Termination.** This Agreement may be terminated without any fee reduction (i) by Licensee without cause on 30 days notice; (ii) by SMI, in addition to other remedies, if Licensee fails to cure any breach of its obligations hereunder within 30 days of notice thereof; (iii) on notice by either party if the other party ceases to do business in the normal course, becomes insolvent, or becomes subject to any bankruptcy, insolvency, or equivalent proceedings. Upon termination by either party for any reason, Licensee shall at SMI’s instructions immediately destroy or return the Licensed Materials and all copies thereof to SMI and delete the Software and all copies thereof from the Designated Equipment.

12. **Entire Agreement; Written Form Requirement.** There are no separate oral agreements; any supplementary agreements or modifications hereto must be made in writing. This also applies to any waiver of this requirement of written form.

13. **Notices.** All notices under the Agreement must be in writing and shall be delivered by hand or by overnight courier to the addresses of the parties set forth above.

14. **Applicable Law and Jurisdiction.** German law applies with the exception of its conflict of laws rules. The application of the United Nations Convention on Contracts for the International Sale of Goods (CISG) is expressly excluded. The courts of Berlin, Germany, shall have exclusive jurisdiction for any action brought under or in connection with this Agreement.
11 About SMI

SensoMotoric Instruments® (SMI) was founded in 1991 by a group of research scientists, physicians, and engineers in order to pursue the commercial development of measurement and evaluation systems in the field of medicine, psychology, ergonomics, human factors, and virtual reality. SMI specializes in development and system integration in the field of video and sensor technology, associated with digital image and signal processing. In 1992, SMI was awarded the Innovation Prize of Berlin-Brandenburg for VOG - Video-Oculography, its video-based eye movement technology.

This technology has found widespread use in the medical diagnosis and research of eye movement, psychology research as well as in specific research applications, for example on the space station MIR. For further development SMI collaborates with leading clinical and research laboratories and partners around the world.

Please contact us:

SensoMotoric Instruments GmbH (SMI)
Warthestraße 21
D-14513 Teltow
Germany
Phone: +49 3328 3955 0
Fax: +49 3328 3955 99
email: info@smi.de

SensoMotoric Instruments, Inc.
28 Atlantic Avenue
236 Lewis Wharf
Boston, MA 02110
USA

Phone: +1 - 617 - 557 - 0010
Fax: +1 - 617 - 507 - 83 19
Toll-Free: 888 SMI USA1
email: info@smivision.com
Please also visit our homepage: http://www.smivision.com

Copyright © 2017 SensoMotoric Instruments GmbH

Last updated: January 2017
Index

- A -
About SMI 252
Analysis
   BeGaze 185
   Subject Protocol 184
Application Window 158

- B -
Basic Operation 25
BeGaze 185

- C -
Calibration 177
   Background Information 228, 229
   Setting 72
   Tips 179
   Verification Picture 177
Commands 163
Connection Settings 29, 34
Copyright 242, 244
CSV 184

- D -
Data Paths 29, 188
Data Storage Structure 187, 190, 191
   Experiment 190
   Results 191
Delete 51
Directory Structure 188
Dongle

- E -
Experiment 188, 190
   Analyzing Measurement Data 185
   Basic Operation 25
   Calibration 177
   Change 47
   Delete 51
   Directory Structure 188
   Dry Run 171
   End 183
   Execution 181
   File 190
   Load 47
   New 46
   Run 172
   Save 49
   Start 175
Experiments
   Import and Export 189
Export Measurement Data 185
Exporting Experiments 189
External Video 200

- F -
Features 23
File 190, 191
   Experiment 190

General Information 11
Installation 199
Troubleshooting 199
Double Monitor Settings 37
Double PC Setup 26, 29, 34
Dry Run 171
Index

File 190, 191
  Formats 194
  Results 191
Firewall Settings 34

- G -
Gaze Data 179
Global Settings 29

- H -
Hotkeys 167, 181

- I -
IDF file 191
Importing Experiments 189
Installation 230
Introduction 2
iView X 45

- K -
Keys 167

- L -
License
  Agreement 244
  Update 11
Load 47

- M -
Media Types 194
Menu Commands 163

- N -
Network 29, 34

- O -
Open 47
Overview 23

- P -
Point of Regard 179
Product Variants 9
Program
  Installation 230
Protocol 183, 184

- R -
Randomization Groups 135
Record 180
Recording
  End 183
  Presentation 181
  Start 175
  Step-by-Step 172
Remote Path 29, 34
Requirements 231
Results 191

- S -
Safety Instructions 7
Save 49
Scrambling Groups 135
Security Advice 7
Settings
Experiment Center

Settings
- Connection 29
- Double Monitor 37
- Network 34
- Subject Properties 142

Setup 26

Software Version 5

Starting Experiment Center 45

Step-by-step Instructions 44

Stimulus
- External Video 125
- Image 94
- Monitor 175
- Movie 113
- PDF 87
- Question 91
- Questionnaire 91
- Random Order 135
- Reference 181
- Screen Recording 117
- Set 66
- Text 82
- Web 106, 180

Subject Information 175

Subject Properties 142

Subject Protocol 184

Supported File Formats 194

System
- Requirements 231
- Setup 26

Toolbars 160

Trademarks 242

Troubleshooting 235

User Interface 158
- Application Window 158
- Keys 167
- Menu Commands 163
- Text Editor Window 169
- Toolbars 160

Validation 78

Verification Picture 177

Warranty 244

Workflow 25